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We’re living in the future. Isn’t that how it 
feels? Our lives are filled with the sort of 
technology advancements that seem as if 
they’ve arrived from a place beyond today. 
(I wonder if life has always felt this way – 
as if we’re already ahead of ourselves?) 

When the likes of John Berkey, John 
Harris and Peter Elson created their 

futuristic imagery, did they believe that, one day, life would become 
like how they painted? Would space travel be a daily occurrence; alien 
life an accepted existence? And if some of this fiction becomes fact, 
would we treat it well? I dread to think. 

Sci-fi art clearly represents the fantastical, but it’s also a promise of 
what life could be like with a little imagination or discovery. There’s 
something about it that’s so… hopeful. Turn to page 38 for an 
inspiring wander through an amazing collection of Space Opera sci-fi 
art. Both classic and modern artists are represented. 

As for you as an artist, you have the most amazing set of digital 
tools available to you to help create your art: Photoshop, Painter, 
Cintiqs and graphics tablets. Certainly, you should learn how to use 
this software and hardware to its best advantage (and from page 58, a 
collection of the finest artists share their digital art secrets with you), 
but make sure you remember what it is that makes your art unique. 
You. Learning an array of techniques will only get you so far. What 
happens beyond the Wacom pen is up to you – and it’s this addition 
that will future proof your art and make it stand the test of time. 

Editor’s letter
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THE PLACE TO SHARE YOUR FANTASY ART

Sebastien Hue
LOCATION: France
WEB: www.shue-digital.com
EMAIL: shuedigital@gmail.com
MEDIA: Photoshop, 3ds Max, 
Vue, ZBrush

Inspired by the likes of 
Dylan Cole, Sebastien 
decided to teach himself 
the ins and outs of digital 
painting, initially starting 

out with Photoshop. “I used to make 
logos for music bands, but I eventually 
progressed deeper into CG graphics, 3D 
programs and matte painting.” 

A far cry from band logos, Sebastien 
certainly had a hidden talent for 
imagining spectacular landscapes. 
Fuelled by his wider passions, the 
Parisian artist channels his love for 
science fiction and the diversity of the 
visual arts straight into his work, seeking 
to add scale, depth and drama into his 
intricately detailed designs.

1SULPHURYGEN “This was a 2D matte 
painting from an original plate shot in 

a refinery. This overview was turned 
into a dramatic sci-fi scene with aliens 
living around it.”

2TERMINAL 13 “The aim was to 
create a massive space station 

inspired by sci-fi blockbusters. The 
terrain was modelled in Vue followed by 
heavy rendering in Photoshop.”

3THE VALLEY OF GAIA “Made for the 
Luminarium collective and mostly 

designed in 3D with Vue and 3ds Max, 
before heavily working on it in 
Photoshop. When modelling the ships 
I took inspiration from Warren Fu.” 

4COMMANDER SUB ZERO “I made 
this entirely in Photoshop, and 

wanted to create a character based on 
three main strands of inspiration. Halo 
was one such source.” 
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ARTIST OF THE MONTH
Congratulations Sebastien – you’ve won 
yourself a copy of Exposé 11 and 
d’artiste: Character Design! To find out 
more about these two great books, go 
to www.ballisticpublishing.com.
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Seattle-based games artist Mike McCain is 
impressed with Sebastien’s grand scenes

“There’s a strong sense of scale here. The 
tilt of the camera engages us, and we’re 
left to wonder just how far this colossal 
installation extends into the distance.”

3 4
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1ZELDA PORTRAIT “I love the 
Zelda games, and Princess Zelda  

is one of my all-time favourite characters. 
Here, I wanted to make her appear more 
realistic looking.” 

2SELF PORTRAIT AS VIGÉE-LE BRUN 
“My study of the artist Louise 

Élisabeth Vigée-Le Brun. I learned a lot 
copying from the old masters, and I love 
her artwork. I tried to mimic her style 
and brushstrokes, but wanted to change 
the features of her face.

3EPIC OWL “Like many, I grew up 
watching Disney and have taken a 

bit of influence from that. My little sister 
asked me to make a cute owl for her, 
and it’s become my mascot.” 

Aline Mendes
LOCATION: Brazil 
WEB: www.alinemendes.deviantart.com
EMAIL: commissionaline@hotmail.com
MEDIA: Photoshop, Painter

As a teenager, Aline grew 
up in awe of the creativity 
found in manga, animation 
and video games, which 
pushed her to explore the 

world of digital art. 
“When I was 19, I wanted to sharpen 

my skills further,” she says, “so I decided 
to study as hard as I could. Now I’m 22, 
my passion for art grows stronger every 
day, and I want to focus more and more 
on my own fantasy world.” 

When Aline isn’t busy taking note  
of the old masters or her favourite video 
games, she can usually be found 
searching the internet for new sources 
of inspiration. “I’m also trying to get into 
working as a freelance artist, and am 
always on the lookout for things to help 
me along the way.”
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IMAGINEFX CRIT
“It’s great to see 
not only some 
imaginative art 

work from Daria, but also 
the backstory behind 
images like A Boy and his 
golem. At the Bridge also 
captures a specific 
moment in time. This art 
is all about telling a story.” 
Beren Neale,
Digital Editor
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1A BOY AND HIS GOLEM “The boy’s 
name is Felix and he found himself  

a very peculiar friend – a golem! They 
travel across ancient cities and have 
many fantastic adventures. I’ve got an 
idea for a full story, and I’d love to write 
it out one day.” 

2AT THE BRIDGE “I wanted to 
capture that fantastic time of a day 

when the sun is about to rise, casting a 
beautiful reddish light. I was inspired by 
the background styles of the animated 
series Gravity Falls, as they are a perfect 
example of creating amazing mood with 
light and colours.”

3THE MORNING AFTER “An updated 
version of a piece I made back in 

2008. I wanted to challenge myself in 
painting fabric and see how I’ve 
improved overall. I love the early 
morning light when you can lazily lie  
in your bed dreaming…”

Daria  
Widermanska-Spala

LOCATION: Poland
WEB: www.anako.pl
EMAIL: daria@anako.pl
MEDIA: Photoshop

For Daria, one of the 
greatest things about 
digital art is that you can 
change your style on a 
whim to better suit your 

theme if you fancy. “I can’t stick to one 
style!” she says. “Each of my pictures is 
like a totally different story, with a 
different approach and unique feelings. 
Maybe I’ll find my own distinctive style 
one day, but for now I’m just happy with 
experimenting and being able to change 
depending on my needs.” 

The enigmatic artist has always loved 
creating art, but became really 
immersed in her late teens. Studying art 
at college opened her eyes to all kinds 
of techniques, from animation to 3D 
graphics. “I’m especially fond of 
creating characters, imagining their 
worlds, lives and adventures.”

IMAGIIIAA NEFX FF CRIIIIT
“It’s great to see 
not only some 
imaginative art 

work from Daria, but als
the backstory behind 
images like A Boy and h
golem. At the Bridge also
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moment in time. This ar
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Badr Douah
LOCATION: Morocco
WEB: www.douahbadr.weebly.com
EMAIL: badr_douah@yahoo.fr
MEDIA: Photoshop

With something of a soft 
spot for dreaming up 
environments, Badr spends 
his time working as a 
freelance concept artist in 

his homeland of Morocco. Since 
studying 3D modelling for videogames 
at Art College, he has worked for Ubisoft 
Casablanca on a number of projects. 

“I’m always looking for new ways to 
learn and improve my creative skills,” 
says Badr, often turning to his passions 
for adventure, travel, videogames and 
the arts for inspiration. Always keen for 
a new challenge to test out his skills, 
Badr is looking forward to the creative 
months ahead. “I can’t wait to see where 
art will take me this year!” 

1BACK HOME “This was the last 
painting I did in 2012. It’s about a man 

who usually lives far away from his old 
home coming back to celebrate 
Christmas with his family.” 

2FACE À FACE “The title is in 
French. In English it would mean 

‘face to face’, which is exactly what’s 
going on here with these frigates. 
I’ve always loved tall ships and so 
wanted to paint them within a dramatic 
scene. They always prove to be an 
interesting subject.”

3SURPRISE “I originally wanted to 
paint a nice sea environment scene, 

but I suddenly had the idea of adding 
a bit more of a story to it.”
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IMAGINEFX CRIT
“I’m struck by Badr’s 
use of composition 
in the image 

Surprise. The tumultuous 
clouds rumble menacingly 
across the painting, 
hovering over the calm 
waves, yet hinting at some 
form of trouble ahead for 
the beached whale.” 
Claire Howlett,
Editor
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1BARBARIAN “This is a portrait 
of my wife! I wanted to create a 

character that portrayed the savagery 
of the Barbarians, but who also had 
a lot of charm and beauty.” 

2GOBLINS: “This was created for 
a CCG Berserk contest. Goblins 

are always interesting to paint. You 
can always get a sense of their mischief, 
no matter what.” 

3BEAST “This character was drawn in 
a weekly art contest. I decided to 

give him a bit of an Indian heritage, like 
the Rakshas spirit in Hindu mythology.”

Evgeny Bakulin
LOCATION: Russia
WEB: www.monorok.daportfolio.com
EMAIL: monorok@gmail.com
MEDIA: Photoshop

Evgeny managed to get  
an early break in the 
videogames industry while 
balancing his art studies 
with working as a 3D artist. 

“After a few years of working in 3D, 
I shifted to becoming a 2D artist, as 
I felt it was closer to me,” he says. “I 
started to attend evening courses in 
classical techniques while also studying 
digital painting.” 

All that extra work paid off, as he now 
works as a full time illustrator and 
concept artist, also taking commissions 
on the side. “When it comes to art, I’ve 
always been drawn to romanticism. I’ve 
always liked thought-provoking 
imagery and dramatic stories.” 

12 November 2013 FXPosé submissions to: fxpose@imaginefx.com

Evgen Bakulin
LO
W m
EMA

EDIA: Ph

1

2

3

2G
a

a

3B
a

g

1BA
of

c



Andrea Femerstrand
LOCATION: Sweden
WEB: www.noukah.blogspot.com
EMAIL: contact@noukah.com
MEDIA: Photoshop

We featured Andrea back 
in issue 62, but she feels 
her skills have grown so 
much since then she 
wanted to bring us up to 

speed. She’s currently working part time 
as a concept artist at an online games 
company and as a freelancer for 
HarperCollins and Kamratposten.

“I’ve been painting digitally since 
I first discovered Photoshop when I was 
14, and got totally hooked from there. 
I started to take it more seriously in my 
twenties, and tried to develop my digital 
skills as much as possible. Just like 
everyone else, I try to sketch and draw 
everyday. It’s always been my number 
one obsession!”

1THE DONUT “This is just something 
really silly and spontaneous. I had a lot 

of fun painting this one!”

2THE CAT HOBBIT “I was lurking 
around on the internet – just an 

ordinary day. Some people were posting 
about The Hobbit, and I looked over at 
our two sleepy cats next to me, and 
something suddenly clicked. Rosso and 
Java – they were just perfect for this!”
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IMAGINEFX CRIT
“Andrea’s cat spoof 
of The Hobbit is 
purrrrfect. I love 

how the warm colouring 
of the cat really pushes 
him forward on the cool 
coloured background. The 
eye and hair details really 
set the persona of the 
character. I would love to 
see this as animation.” 
Daniel Vincent,
Art Editor
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IMAGINEFX CRIT
“The dark and 
whimsical design of 
Beñat’s art can’t fail 

to engage you, especially 
when he plays with 
composition in My Last 
Breath. I particularly love 
the wide-eyed owl’s 
energy as it’s released.” 
Ian Dean,
Associate Editor
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1DEADLICIOUS! “Illustration for 
The Zombook, an enormous art 

compilation about zombies by Allan 
Graves. ’Cos pin-up girls rock!”

2MY LAST BREATH “Created for 
Twisted Essence, the ninth 

Hysterical Minds exhibition. We had to 
avoid using a central composition, and 
I wanted to represent the last hope of 
someone with the power to create life.”

3FROZEN HEART “Created for 
Substantia, the twelfth Hysterical 

Minds exhibition. The challenge was to 
create a freezing environment.”

Beñat Olea Irureta
LOCATION: Spain
WEB: www.obscurebt.blogspot.com
EMAIL: bt_olea@hotmail.com
MEDIA: Photoshop

If you’re a keen follower of 
Hysterical Minds, there’s a 
chance that you may have 
become acquainted with 
Beñat’s intriguing blend of 

whimsical fantasy and playful horror. 
“I see my work as a mix of darkness 
and beauty, but always with a touch 
of innocence,” he says. “I love creating 
magical and quirky worlds with 
characters that are capable of touching 
the viewer and transporting them into 
their strange existence.” 

Beñat studied Fine Arts with Graphic 
and Web Design, and currently works as 
a freelance illustrator, primarily in the 
children’s market (although toning down 
the horror accordingly). “I’m inspired by 
growing up with comics, videogames, 
animation and horror films, and all these 
together really influence my style.”
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Original cover artist 
Dave McKean is also 
bringing his intimate 
knowledge of The 
Sandman to the  
new project.

ARTIST NEWS, SOFTWARE     EVENTS

AT THE CORE OF THE FANTASY ART COMMUNITY
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What was the biggest challenge 
you faced in rebooting 
something so popular?
The challenge, as I saw it, was 
simply to do a good job and get  
the completed pages in on time.  
I worked eight days straight on 
completing the painted cover (some 
of which got cropped due to the 
format they employed), and  
48 straight days to finish the inside 
art, which for me included drawing, 
inking and lettering. An amazing, 
exhilarating and exhausting 
marathon of work for sure!

How did you approach the art? 
Did you consciously try to ape 
Dave Gibbons’ style or use  
1986-era techniques?
I approached the art with a mind 
for the late 1940s and 50s. A lot of 
period research was necessary 
throughout every page of the entire 
24 page book, including clothing, 
buildings, cars, and every aspect  
of daily life during that time.

In what ways do you think 
Before Watchmen would have 
been different had Alan Moore 
been on board?
I’m not sure, since to my knowledge 
Mr Moore turned down any 
involvement with the Watchmen 
revival project.

Watchmen and The Sandman 
are considered classics of the 
genre – what do you think it is 
about these titles that has made 
them stand the test of time?
I recall reading the books when 
they came out, but not much more. 
I’m sure there was far greater 
enthusiasm from people other than 
myself at the time – and of course  
I know its popularity has thrived 
for several decades since its 
groundbreaking release.

INDUSTRY INSIGHT

STEVE
RUDE

Reviving classics isn’t new, says 
the Before Watchmen artist

Steve is working on the next 
Nexus, for Dark Horse 
Presents, and leading a class  
in figure painting in Arizona.

www.steverude.com

 The anniversary 
was a huge part of 
why I wanted to 
come back and do 
another one 

Re-enter 
Sandman
Wildest dreams Neil Gaiman’s shape-shifting protagonist is back – 
so what can we expect from the return of The Sandman?

GOT AN 
INKLING?
There were some 
fantastic entries to our 
online sketch challenge 
and four lucky readers 
earned themselves 
Wacom Inklings for 
their inspired work.
Page 19

THIS LITTLE 
PIGGY...
Ex Darksiders artists 
have make art for 
Substrata, including  
this menacing swine 
you probably wouldn’t 
be tempted to recite 
nursery rhymes to.
Page 21

GAME OF 
THRONE
With a Gothic throne 
(we want!) as the 
striking centrepiece, 
Anne Stokes shares her 
creative space with two 
other artists – in the 
Tower of Art.   
Page 22

The mid- to late-80s are considered a real 

turning point for graphic novels and their 

acceptance by the mainstream media. 

Alan Moore’s Watchmen turned typical 

superheroes into losers and fantasists, 

Frank Miller’s The Dark Knight Returns 

gave Batman a dark and brooding twist 

and, perhaps most importantly of all,  

Neil Gaiman’s The Sandman proved that 

comics could tell a proper, 

allegorical story.

While The Dark Knight 

Returns informed Christopher 

Nolan’s cinematic visions of 

Gotham, and Watchmen was given a full-

bodied film adaptation and prequel comic 

book series, The Sandman has sat – much 

like its titular character – imprisoned and 

unloved. Until now that is, with the 

announcement that Neil is to return to  

the series with a prequel, The Sandman: 

Overture, just in time for the original’s  

25th birthday.

“The anniversary was a huge part of why  

I wanted to come back and do another 

Sandman story,” says Neil. “Twenty-five 

years is huge in the lifetime of a comic.  

I grew up reading comics, and the high point 

for me would have been 1973, 74, 75. The 

idea back then that a comic that started in 

the 40s would still be relevant and exciting 

years later would have been unthinkable.”

Overture will tell the story of how the 

Sandman found himself in such a sticky 

wicket in the original. If you haven’t read it 

(for shame!), the story opens with the 

mysterious and supernaturally powered 

Sandman captured by an occultist who 

seeks immortality. What we don’t know is 

why it was so easy to capture this all-

powerful character, and why he was so 

JH’s first page of the 
first issue – a brilliant 
illustration of what’s  
to come.

“What did you most  
like in this story to 
depict?” we asked JH. 
“Everything,” he said.
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worn out. According to Neil: 

“There are so many things that 

we never found out. And I knew 

them all.”

Unlike the original series, 

which flitted between artists 

and styles, Neil is working with  

a single illustrator for Overture 

– Promethea and Desolation 

Jones’s JH Williams III. Their 

paths crossed 

years ago at San 

Diego Comic-Con. 

Neil had just 

stepped out of a 

cab and was talking to others. “I 

very rudely inserted myself into 

the group, introducing myself 

and saying something stupidly 

gushing I’m sure,” says JH. “That 

I was the artist on Promethea, 

and if he ever wished to work on 

something with me, I would love 

to draw a story of his.” 

A few years later JH received 

an email from Vertigo spelling 

out the new Sandman project. 

“Neil had never forgotten how 

much it clearly would mean to 

me to draw a story for him. And 

he sweetly still says that I wasn’t 

rude all those years ago.”

Despite JH’s unabashed 

enthusiasm for working with 

Neil, he’s aware he’s taking on a 

mighty title. “It is quite different 

for me than coming onto 

something like, say, Batman or 

another well-known character,” 

he says. “Sandman was so much 

beyond those things, so highly 

revered, not just by myself, but 

legions of readers. I just have to 

do the best work I can, and 

hope it’s enough.” 

We’re looking forward to seeing more 
images like this dream-like painting  
of The Sandman.

Epic art on  
a small scale

Looking for a way to warm up every day 

before the hard graft of drawing comics  

for a living, artist Marcio Takara came up 

with the  idea of rendering his favourite 

characters from comics, video games and 

movies in a miniature style.

“The idea was for me to have an excuse to draw as many 

different characters as I could,” says Marcio. “They’re usually 

super fast to finish. But most of all, it was a great way to 

interact with fans online.”

Each tiny portrait – about four-inches tall on paper – takes 

Marcio between 10 and 20 minutes to complete. He drafts 

them using pencil and ink before adding colour in Photoshop.

With 100 characters already drawn, Marcio admits it was 

hard keeping track of who was drawn. “After a while I was 

just drawing whatever came to my mind at the moment. 

Basically characters I like,” admits the obsessed artist, who 

has now downed tools. “I told myself that I would never go 

back to them, but who knows…”

See more of Marcio’s work at www.bit.ly/marcioart.

Mini Marvels Marcio Takara has a 
unique way to warm up for work

Past and future secret

Fan art gets a bad reputation, but professional artist 

Mélanie Delon uses her love of video game Mass Effect  

to broaden her skill set.

“It’s a lot of fun and often quite different 

from what I usually do, so it’s really refreshing 

and challenging,” says Mélanie, who’s better 

known for her beautiful and delicate female 

portraits than hard sci-fi. “I don’t produce a 

lot of fan art – indeed, Shepard is my second one. It may 

sound crazy, but after finishing the game I needed to say 

goodbye to this awesome character, and painting her was 

the best way I found.”

Fan art How a love of Mass Effect helped Mélanie Delon step outside  
her artistic comfort zone – and in doing so develop her portfolio

Having explored sci-fi in her 
fan art, Mélanie used her new 
techniques to paint this 
stunning sci-fi painting.

Focusing on drawing out key characteristics of the 

game’s lead character, Mélanie’s painting captures the 

Shepard’s determination as well as a nostalgic yearning for 

the character’s struggle. “It was important to have this tragic 

feeling in her eyes,” confirms the artist.

With her fan art piece complete, Mélanie has fallen in love 

with sci-fi. “I love painting beautiful gowns,” explains the 

artist. “But creating space suits, lens flare, and painting  

a crazy Milky Way is just so cool!” 

Which all goes to prove that sometimes it pays to step 

outside your comfort zone. You can see more of Mélanie’s 

art at www.melaniedelon.com.

MéMélanie Delon u
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“This makes me hyped to post more of my 
artwork on your website,” says Ramon 

after winning in our online challenge.

Visitors to ImagineFX.com have been 

challenged to enter our Inkling weekly 

sketch jam competition, with the chance 

to win a Wacom Inkling. After being 

deluged with some amazing entries we’ve 

managed to choose four lucky winners, 

one from each of our categories.

In the Summertime in Middle-earth 

category Lucie Hendrychova 

was chosen for her light touch 

and sense of fun, as she 

depicts Treebeard in playful 

mood by the river with Shire 

folk. “He likes their laughter and after the 

bathing, when little Hobbits are drying up on 

his branches, he starts a storytelling with ‘A 

long looong time ago…’” embellishes Lucie. 

“I wish I was there myself.”

In the Forest Nymph 

category Ramon Puasa Jr’s 

wispy pen and paper sketch 

caught our eye. “When I think 

Artist news, software & events
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“One of my strongest childhood 
memories is of outdoor  
swimming, sunshine and  
tree shadows,” says Lucie.

Mat’s depiction of a space 
marine reclining with a cocktail 

caught our eye.Inkling winners drawn
Daring doodles Did you win an Inkling? We reveal the lucky 
winners of our online sketch challenge… 

about nymphs they should look really 

beautiful, as if they can bewitch whoever 

sees them,” explains Ramon. “I really wanted 

my character sketch to have an ornate, very 

detailed outfit made of wood, leaves and 

flowers rather than a normal, naked figure 

with a leaf and twigs headdress.”

Over in the Fantasy Festival Band section 

we chose Pascal Heinzelmann’s inventive 

take on the theme; many 

creatures scurry around a 

giant instrument carved from 

a tree. “I feel honoured,” says 

Pascal at the news. “Being at 

the beginning of my career, it’s very 

motivating to win a sketch competition.”

Finally, we’re pleased to reveal Mat 

Edwards won an Inkling for his Shore Leave 

sketch, chosen for its attention to detail and 

fantastically posed character.

Congratulations to all our winners and 

thanks to everyone for entering!

“I just did the opposite of a 
one-man band – many creatures 

playing one giant instrument,” 
quips Inkling winner Pascal.

y Lucie Hendrychova 

ory Ramon Puasa Jr’s 



Just finished something you want us to shout 
about? Send it our way on Twitter 
(@imaginefx), or find us on Facebook! 

Your art news that’s 
grabbed our attention

 Manuel  
Morgado

”A naughty Snow 
White meets the  
Wizard of Oz…” 
www.bit.ly/ifx-m-morgado   

 Simon  
Sherry

”So I figured, 
why not do this…” 
www.bit.ly/ifx-simonsherry

 Noriyuki Kubo  
(@EISAKUSAKU) 

”Finished with 
highlights and details in 
white coloured pencil.” 
www.bit.ly/ifx-eisakusaku

t

Hatboy
by Vaughn Pinpin

Just finished something you want us to shout 
about? Send it our way on Twitter 
(@imaginefx), or find us on Facebook!

Fantasy talk Explaining the inexplicable
“Different types of strangeness can seem threatening, gracile, 
vulnerable, sophisticated, or primitive without being overt.“
Keith Thompson attempts to define the essence of strangeness in an alien. Gracile? Wow! Page 64

Enter the CAVE

If you want to brush up on your art skills 

and get inspired by talks from a roster of 

exciting speakers that includes Liam 

Sharp, Neil Gaiman and Lorne Lanning, 

then Autodesk’s CAVE conference should 

already be in your diary. And if it’s not,  

put it in there right now. Starting on  

2 December at the Venetian Hotel in Las 

Vegas, CAVE aims to bridge the gap 

between design and fine art, fashion and 

sci-fi concepts.

“This new conference provides a new 

platform for creative professionals from all 

walks of life to bathe in the majesty of 

imagination,” explains Autodesk’s Chris 

Cheung of this interesting event. “Everyone 

can benefit from a major injection of 

knowledge and inspiration,” he adds, 

excitedly, “mixing talent from cross-

disciplines, the legendary veterans and the 

young emerging professionals is what CAVE 

Conference is about!”

Cave of creativity Escape the winter weather and mix your passions 
at Autodesk’s unique Las Vegas conference

The show will mix masterclass tutorials 

with lectures and informal meet and greets, 

so you can brush up on your Maya and 

SketchBook Pro skills while 

picking up tips from Syd 

Mead and Scott Robertson 

over a coffee. And continuing 

the show’s eclectic mix, even 

the legendary John Cleese will 

be on hand to inspire you. 

“We’re sculpting the 

program to expose a cross-

section of ideas,” explains 

Chris. “Our hope is that 

attendees will get that Wow! 

moment.” Start planning your 

Wow! moment now by visiting 

www.autodeskcave.com.

Terryl Whitlatch will be 
among the keynote speakers 
and teachers that will pool 
creatives from the arts, film, 
games and book industries.
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Although the brief was open ended, Paul’s own version of Substrata revolved around an afterlife for plants.

Our Colour and Light 
cover artist Helen 

Rusovich returns for 
another colour-themed 

character study. The darkest kind of fantasy

Earlier this year, the news of the closure of 

Vigil Games – the studio behind the 

Darksiders franchise – was a major blow. 

But as the saying goes, as one door closes, 

another opens.

As a bid to reunite former Vigil artists, 

Paul Richards decided to launch an open-

submission art book based on Substrata, a 

hypothetical dark fantasy game in the early 

stages of pre-production. “The group is 

already steeped in dark 

fantasy, so this was the best 

way to get them excited,” says 

Paul, who wanted the project 

to enable artists to experiment 

with twisted concepts that would scare 

conventional publishers. “We wanted all of 

the things you’re not supposed to do, with 

an open-ended design brief where people 

could choose from an array of game-driven 

content. Some decided to deliver on one 

aspect, while others conducted a more 

thorough exploration of their own universe.”

   Substrata is expected to be 

released early to mid-2014. Keep checking 

www.autodestruct.com for more. 

Open world Introducing Substrata, the hypothetical video 
game from the creative visionaries of Darksiders and beyond 
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We’d love to see these 

quirky creatures by 
Peter Boehme realised 

in a finished game.
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very top floor is an open-plan studio. John 

and Geof are both great company, and 

collectively we have made a unique and 

inspirational place to work.

I start my day with a cup of tea, usually 

followed by answering a barrage of emails. 

The way that I work is to concept and paint 

ranges of fantasy-themed artworks, which 

are then licensed to various different 

companies for use on their products. I work 

Here are some of the many gems we 
found on the pages of deviantART…

+deviantWATCH

I work in a place called The 

Tower of Art, which is in 

Leeds. I share this building 

with two other artists, John 

Woodward and Geof 

Banyard. The building used to belong to a 

furniture manufacturer before we took it 

over, and is a great space to have. 

The ground floor is a workshop, the 

middle floor holds several offices, and the 

Anne Stokes
Black tower Deep within the mysterious wilds of Yorkshire, legend 
speaks of an old tower, home to many dark creations…

Dibujante-nocturno
www.bit.ly/ifx-dnocturno

If you’re into your dark fantasy, 
you should definitely take a look at 
the macabre works of Spanish 
artist Francisco Garcés. Along with 
many great digital pieces, we love 
his atmospheric ink drawings of 
unsavoury creatures and 
foreboding knights – there’s plenty 
to fill your nightmares with. 

Zephyrhant
www.zephyrhant.deviantart.com

Along with this rather awesome 
Game of Thrones fan piece, there 
are many gorgeous images to be 
found in this elegant collection. 
There’s a hint of Ayami Kojima in 
Zephyrhant’s Gothic style, with 
elaborate costumes, striking eyes 
and muted colours in abundance. 
You won’t be disappointed. 

nosaj7541
www.nosaj7541.deviantart.com

Now here’s one to watch for the 
future: nosaj7541 may only be a 
mere 17 years old, but he’s 
certainly well on his way to 
developing a distinctive style of his 
own. Loose painting styles are all 
the rage, but we haven’t seen 
many as delicate and authentically 
impressionistic as we see here. 

ImagineNation News
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I went to China last year to visit a sculpture company that I work with. It 
was an amazing experience to see such a different culture. I got this cute 
soft toy dragon on my travels, and he now lives on top of my computer.

This old chair may look a little tired, but is just the right height for me. I have had neck 
and back problems, and once I found a comfortable setup I have been keen to stick 
with it. The right posture and monitor height are very important to avoid such issues.

The Tower of Art with 
Geof, John and myself 
standing in front of it.



with an art agency who deal with a lot of the 

contract and paperwork for me, although 

there are always enquiries and product 

approvals to deal with first thing. 

Once the business side of things is taken 

care of, I can get down to the art. I have a 

fairly basic computer setup, using 

Photoshop with a Wacom graphics tablet to 

paint. I’m very used to my setup now, and 

you don’t always need a lot of fancy 

equipment to produce good art. 

The studio space we have upstairs is great 

for setting up reference photographs or for 

just getting a bit of a change of scene. It’s 

great for doing a bit of sketching with pencil 

and paper. A real talking point of the studio 

is the Gothic throne, which was once part of 

an old church. I love this artefact and find it 

very handy for collecting my thoughts and 

planning future projects! 

Anne has been a full time artist for over 15 
years, and her artwork is licensed for a wide 
variety of merchandise, including T-shirts and 
posters. Visit www.annestokes.com for more. 
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The cabinets in my office are filled with product samples 
of sculptures and other items made from my designs. 

The fabulous carved wooden Gothic throne 
used to be part of the furnishings of a church. 
Great for sitting in and planning what to do!

I have replica casts of a dog and cat skeleton, 
which are interesting to look at and great 
reference for anatomy. The basic structure of 
a cat can be especially useful when painting a 
dragon, albeit with a longer neck and wings.
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Win £10,000 worth of prizes! 
There will be one lucky winner 
of all these great prizes from 

well-known brands. Enter 
by text today to be in with 
a chance of grabbing this 
amazing gadget wish list!

The Sigma SD1 packs a lot into its relatively small 
body. It sports a 46-megapixel Foveon X3 sensor, 
which helps you capture every little detail, and its 
7.5cm LCD monitor makes your images look bright 
and crisp. It also offers exceptional image quality,  
and is especially good at low ISO. It’s got a strong, 
weather-resistant magnesium-alloy body, comes 

complete with the Sigma 17-50mm OS Kit lens, 
and retails at £2,150.

Monster® DNA On-Ear Headphones –
 Cobalt Blue

CyberLink PowerDVD 13 Ultra

Sky Broadband Unlimited – free for a year

JVC GC-XA1 Action Camera

Clicloc watch

X Rocker Rockster gaming chair

Phoenix laptop security travel case

Sony BDV-N590W home theatre system

Phoenix laptop security carry case

Phoenix iPad security case

Olloclip Quick-flip case 

Marin Palisades Trail 29er Mountain Bike

David Bowie-inspired Momentum Special 
Edition headphones from Sennheiser

Monster® iSport Victory In-Ear Headphones 

Kaspersky PURE 3.0 

Outride by Mophie iPhone mount

Coleman Da Gama 4 tent  
and Biker sleeping bag

Thin King Anodized aluminium wallet Sky TV free for a year 
and a Sky+HD Box

Monster Game® MVP Carbon On-Ear 
Headphones by EA Sports™ – Black

Sigma SD1 D-SLR 
camera and lens



Terms and Conditions
You must use the keycode ‘IFX’ in your text. The prize draw is only open to UK 
residents. You must be 16 or over to enter. The prize draw is not open to employees 
of Future Publishing and its affiliates or agents, the families of such employees, and 
any other person connected with this promotion. One winner will be chosen from 
all eligible entrants at the close of the prize draw by way of an independently 
supervised random draw. The winner will be notified after the prize draw has 
closed. The winner will be notified by telephone on the telephone number used to 
enter the prize draw. If the winner cannot be contacted, the prize is forfeited and 
we reserve the right to draw another winner. In the event of a dispute, the winner is 
deemed to be the owner of the winning phone number. In the event of an entrant’s 
mobile and/or contact telephone number changing and/or the mobile phone 
being lost, stolen or damaged, the Promoter is not able to retrieve and amend any 
existing entries to a new mobile and/or contact number. Prizes may arrive on 
different dates. The winner may be required to fulfil all reasonable requests to take 
part in publicity relating to this Promotion.

You will find the full prize draw terms and conditions here:  
www.futureplc.com/survey-prizedraw-terms-and-conditions

Hauppauge HD PVR 2 GE Plus  

Monster® ClarityHD Micro  
Bluetooth Speaker – Black

Garmin Edge® 810 – the complete 
touchscreen GPS bike computer

Bladez Bubble Blaster and  
Water Blaster RC helicopters

Kingston Technology MobileLite Wireless 

Mophie Juice Pack

Monitor Audio Wireless multimedia system

Kymera Wand remote control

Air Hogs Helix 4

Monster® High Definition HDP 850G 
PowerCenter™ v2 w/ GreenPower™ – UK

Monster® iCarPlay™ Wireless 800 FM 
Transmitter for iPhone and iPod

PURE Jongo S3 wireless music system

Black MS-2 Marshall Micro Amp

Unit Portables Laptop Bag

D6200 Netgear Wi-Fi router

Sonic Screwdriver remote control

Air Hogs AtmoSphere

Asics Gel Kayano trainers

Magicscreen screen protector pack, a Magicwand 
touch screen stylus, a Magicpotion screen cleaning 

kit, a pair of Artisanphonics luxury wood earphones, 
and a case from the MediaDevil range

Mutewatch touchscreen watch

Zoom G5 Guitar Effects and  
Amp Simulator Pedal

Humax YouView box DTR-T1000

Netgear PTV3000 Wireless display adaptor

Unique Track days Radical 
Driving Experience at Silverstone

HOW TO ENTER

TEXT: IFX
TO 87474

Texts cost £1 plus 1 message at 
your standard network rate, 

usually 10p-12p

Or post your name & contact number to The Future 
Great Gadget Giveaway, c\o Puma Source Solutions 

Ltd, The Lodge, Portobello Docks,  
551 Harrow Road, London, W10 4RH

Increase your chances of
winning by texting again.

Plus, get 3 entries for the price
of 2 – so every third text is free! 

Deadline for entries is 30 November 2013.  
Text entry costs £1 plus your standard network rate.  
To decline marketing texts end your message with 

NOINFO

UK ONLY!
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Issue 100 – your feedback

Magical 
gathering
I just wanted to tell you guys that the 
article on Magic: The Gathering 
artwork [issue 99] was phenomenal! 
It was time for those awesome artists 
to get a feature and I was instantly 
wanting to buy their art book.

Also, your workshops are top 
notch. A couple of years back I was 
kind of hesitant to get more into 
digital art, but I got the anime/
manga magazine (issue 4!) and I was 
instantly trying to do all the 
tutorials! Attached are a couple of 
pics I’ve done recently using those 
workshops. Now my mother gets me 
a subscription to ImagineFX every 
year for Christmas. Best present ever.

Thanks – keep being awesome!
Brittany Foltz, via email

Claire replies Brittany, I agree – 
the Magic: The Gathering feature was 
a real treat to our eyeballs. There was 
just an embarrassingly huge level of 
art skill on show wasn’t there? 
Thanks for sending in your paintings, 
too. We love them.

Remember him
I’m a huge fan of your magazine. Could you 
guys please do an interview with Fred 
Augis, or have him do some kind of 
workshop? His work is amazing. He’s a 
colleague of Aleksi Briclot, who works at 
DONTNOD Entertainment – the company 
responsible for the game Remember  
Me. Anyway, here’s a link to his gallery:  
www.fred-augis.cghub.com/images. His 
work is amazing. Thank you for taking the 
time to read this email from one of  
your fans.
D, via email

Claire replies Thanks so much for 
suggesting Fred – his work is indeed 
amazing. Look out for something from  
him in a forthcoming issue…

American girl
I’d like to submit my latest work done with 
SketchBook Pro. Attached you can find an 
image. Thanks for your attention.
Davide, via email

DID YOU MISS 
ISSUE 100?  
We’ve still got  
a few copies, but 
you need to move 
fast! See page 78 
for details on 
how to get hold 
of one.

Claire replies  That’s a very beautiful 
painting, Davide, thanks so much for 
sending this in.

Model interest
Since purchasing a recent copy of your 
magazine, Fantasy Art Essentials, I have a 
considerable interest in the person you 
featured on the cover. The cover model was 
alone and toting some sort of long axe and 
standing in front of a dormant relic of a tree. 
I am interested in this model’s appearance 
and would gratefully appreciate you sending 
her this letter for consideration. I am trained 
in art from university and am considering 
some sculpture. I would appreciate any 
action you take in putting me in touch with 
the model in your magazine. 
G Moore, England

Claire replies Thanks for your letter,  
G Moore. The beautiful cover art for Fantasy 
Art Essentials was created by the very 
talented Julie Bell. She would have chosen 
this model, and I don’t know who it is. Julie 
sometimes uses herself as the model, but  
I don’t think this is the case here. You can 
visit www.imaginistix.com for more 
beautiful art from Julie. 

This is Davide’s painting, done in SketchBook Pro. Please 
keep sending your art in, readers – we love to see it.

Chilling for the night, 
reading the 100th issue 
of your magazine and 
taking the tips and 
advice in like a sponge 
in prep for my degree 
and loving every 
second. Thanks 
ImagineFX. My aim is  
to get onto that top  
100 artists list! 
Wahooooooo! 
Johanson Al, via Facebook 

Got my 100th issue  
of @imaginefx today. 
Taken back a bit by the 
amount of content – 
great work guys ‘n’ girls! 
Good to see Claire  
back too. 
@GerBeeDee, Twitter

Terrific 100th issue. 
Very inspirational and 
great to see the top 100 
fave artists supplement.  
Emlyn Boyle, via Facebook

Happy anniversary, 
ImagineFX staff! 
Thanks so much for 
your continued 
awesome efforts in 
putting out one of the 
absolute best art 
publications available. 
Here’s to another  
100 issues!  
Jonathan Richard Walters, 
via Facebook

Just got my 
subscriber’s issue 100  
in the post. Super 

pleased, well done 
ImagineFX! Here’s to 
the next 100 issues. 
Kim Bowman,  
via Facebook

We asked on Twitter 
what your favourite 
ImagineFX cover is…
@imaginefx Gonna go 
with this sci-fi beauty! 
#imaginefx100  
@i_k1ng

@imaginefx 
The Adi Granov - 
Cyclops and Jean Grey 
one! Watching the 
tutorial was the bomb! 
@awkwarddesigner

ImagineNation
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Our star letter writer wins a  
dA Premium Membership!
 Browse more content more quickly  
 Customise your profile page Receive 

exclusive discounts & offers  And more!

YOUR FEEDBACK & OPINIONS
Contact the editor, Claire Howlett, 
on claire.howlett@futurenet.com 
or write to ImagineFX, Future 
Publishing, 30 Monmouth Street, 
Bath, BA1 2BW, UK

, Claire Howlett,

Thi i D id ’ p i ti d i Sk t hB k P Pl

S

Follow us on twitter: 
www.twitter.com/imaginefx
Tell us your thoughts on: 
www.facebook.com/imaginefx

@ _ g

DIG

Brittany loved our Magic: The Gathering 
feature – and she sent some of her art in.
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Get our digital edition!
Apple NApple Newsewssstand: ta dd  www bi /ddd ifdd i /nddddnddnnnnn ::: wwwww b t ifwwwwnnnnd:::::dddddddd:: w.b.biittd: w w bit.l.llyy/ifx-appy//iiffxx--apappp

Android, PC & Mac: www.zinio.com/imaginefx

Barnes & Noble NOOK: www.bit.ly/ifxnook 

Google Play: www.bit.ly/maggoogle

*Free trial not available on Zinio.
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GOT A QUESTION FOR OUR EXPERTS? LET US
EASE YOUR ART-ACHE AT HELP@IMAGINEFX.COM

Answer
Mark replies

Painting a nightmare or a 
horror scene is not necessarily 
about showing horrific things 
in a blatant and obvious way. If 

we go back to the classic horror movies or 
to the films of old masters like Hitchcock, 
we can see that what they’re doing is more 
playing with the mind and imagination of 
the viewer – in lesser movies the suspense is 
blown as soon as you see the man in the 
rubber suit. The trick is still the same today: 
to paint a really frightening image we 
should only suggest most of the horrors we 
would like to show.

In this case I wanted to depict a 
nightmare where we can’t really decide 
whether we are sleeping or we are awake. 
All of us know this state, where the 

shadows of the moving curtains cast by the 
eerie moonlight could easily turn into 
weird monsters sneaking into our room.

I roughly painted in the silhouette of the 
creature, and I knew from the very 
beginning that I wanted to show only part 
of its face. With every aspect of the image 
creating only one clear focal point – the 
amount of detail, composition, contrast, 
saturation – I was able to focus the eye on 
just a small part of the image, which could 
hint at the rest of the scene.

I consciously placed the ‘camera’ very 
close to the viewer, and also added some 
cinematic effects as the last step. This 
creates the feeling that we are at the very 
moment before the horrific action begins 
– or hopefully just before waking up…

Question
How can I give a scene the feel of a nightmare 
by using shadows and suggestion?
Austen Tassletine, England

Creating a suggestion of the horrific 
things that are just about to reveal 
themselves can be more frightening than 
revealing the whole of the character.

30

ImagineNation Artist Q&A

November 2013

Francesco Lorenzetti
Francesco is a concept artist 
at Atomhawk Design. He 
enjoys working in traditional 
media and often goes to life- 
drawing sessions.

www.bit.ly/ifx-francesco

Mark Molnar
Mark is a concept and visual 
development artist. He’s busy 
doing freelance work for 
international film, game and 
animation companies.

www.markmolnar.com

Manon Delacroix
Manon is a busy freelance 
illustrator who specialises in 
high fantasy, horror and 
portraiture. Werewolves are 
her favourite.

www.artbymanon.com

Nick Harris
Gloucestershire-based Nick 
went digital in 2000 after 18 
years working with traditional 
methods. He works mainly on 
children’s illustrations.

www.nickillus.com

Charlie Bowater
Charlie lives in the north east 
of England. She works as a 
concept artist for Atomhawk 
by day and is a doodler of 
everything else by night.

www.charliebowater.wordpress.com

John Staub
John is an illustrator and 
concept designer based in the 
Bay Area who is currently 
specialising in the games and 
publications field.

www.dustsplat.blogspot.com

Tony Foti
Tony is a US freelance 
illustrator who contributes 
to D&D and Fantasy Flight 
Games’ Star Wars and The 
Lord of the Rings lines.

www.tonyfotiart.com

DIRECT LINK FOR Q&A FILES
www.bit.ly/101-qanda

WATCH THIS!
www.bit.ly/UNI101-nightmare
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Step-by-step:
Use suggestion to 
increase the fear

Question
I need some help with painting blood-splattered 
fur, suggesting that the blood has congealed.
Felix Cortez, US

Answer
Manon replies

The first thing for anything based in 
real life, like blood, is that you want 
lots and lots of photo reference. With 
things like blood spatter though, you 

need to be very careful what you enter as your 
Google search terms or you might not like what 
you find! My most useful search term was “Lion 
bloody face” – animals eating their prey are a 
great source of gore. (You might also get a lot of 
hits for anti-fur campaigns, but they get a bit 
nastier and less fun to look at.)

Blood tends to drip off fur in much the same 
way water does off an animal with a greasy coat 
– it doesn’t necessarily just soak it through.

I made my creature white so that I could 
illustrate the effect. I used a new layer and set that 
layer to Multiply. I then chose a deep rich red and 
a hard round brush with 85 per cent Opacity and 
70 per cent Flow. In the Brush panel, I clicked 
Transfer and selected Pen Pressure (you can play 
around with that until you’re comfortable), then 
under Shape Dynamics set a small Minimum 
Diameter. Now you’re ready to paint in your 
bloody fur. Make sure the fur hangs off the 
animal – the blood will weigh it down and pull it 
toward the ground. Another Multiply layer may 
be needed on top for more intensity.

For the blood 
dripping from long 

fur, imagine the 
clumps of fur are 

V-shaped and 
then, using a very 
light brush stroke 

with light pressure, 
begin to shape 

your bloody fur.

Good reference 
and simple 

techniques will 
give your fantasy 
creature a sense 

of realism. 

 I blocked in the main silhouette of the 
monster first and established the 

overall colour scheme of the illustration. 
I wanted to use a slightly tilted camera 
angle to add more dynamism to the scene.

 Although the lighting would suggest 
a more bluish highlight, I consciously 

used warmer colours for the creature’s 
face. This helped to create a much 
stronger focal point with the strong colour 
contrast of the saturated yellows and reds, 
compared to the desaturated blues and 
greys in the background.

 To achieve more visual noise and 
details in the foreground I applied 

photo textures to the creature. The final 
step was to add extra elements like the 
door frame at the back to support the 
story, then integrated the textures into the 
painting and added some effects to add 
more atmosphere to the image.

CONTRAST AND VARIATION

Even if you’re drawing something really 

gruesome, sometimes it will make it much more 

disturbing if you pair the gruesome with 

something actually quite cute. This sort of 

contrast is very powerful and can make the 

viewer uncomfortable.

Artist’s secret
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STARTING IN COLOUR 
Working in monochrome then 
colouring afterwards is a popular 
process. However for this piece I did the reverse. Working in full colour and then adjusting the Vibrance in PhotoPlus enables me to be more adventurous, and helps me deliver richer results to a muted piece.

Artist’s secret

Answer
John replies

Whenever the word futuristic 
comes to mind, I think of 
shapes that are simple, sleek 
and efficient. If these design 

elements can show through in the overall 
look then I think a convincing, futuristic 
hairstyle can be created. One thing I do is to 
look at fashion related media. By doing so I 
can get a good idea of what are the most 
modern and trendy styles.

Playing around with a variety of overall 
shapes can really get the ideas flowing. The 
key is to keep these shapes simple: they can 
even be geometric in design.

Answer
Mark replies

The key for a successful 
landscape painting is to handle 
the perspective right, and to 
have a pleasing variation in 

terms of rhythm and scale between objects.
A very effective technique is to focus only 

on silhouettes first and create lots of space 
segments (an array of mountains in this 
case) that are becoming lighter towards the 
horizon. After I blocked in the main shapes 
at the thumbnail stage I only had to add 
more details inside them and break up the 
space in between to achieve more depth.

The other thing you may want to try is to 
play with the size of the objects from the 
very small size through to the gigantic. 
When using vertical objects that are bigger 
than our canvas we can create an unusual 
feeling, because it is relatively rare that we 

Adding unnatural colours and bright, 
eye-catching shades is another element that 
could give your hair design that futuristic 
feel. I usually think of those bright neon 
and saturated colours that you would find 
in a club or bar. For me, colours that cannot 
be found in the natural world work best.

cannot see the top of a mountain or 
building in real life. So by placing our 
horizon line closer to the bottom of the 
image we can create even more space for 
these massive objects.

It’s important to add a point of reference, 
as without that the viewer won’t be able to 
feel the actual size of things. The best 
method is to use an object that should be 
easily recognisable and has a definable size.

Question
Have you got any ideas for designing 
futuristic hairstyles for a game I’m creating?
Phil Thompson, US

Question
Got any tips for painting  
a militaristic animal?
Gemma Hastings, Scotland

Answer
Nick replies

There have been all manner of representations of 
anthropomorphic animals, in both illustration and 
more recently cinema, most particularly when using 
CG for amazingly convincing effects over the past 

few years. The original Planet of the Apes film and Tim Burton’s 
recent re-imagining offer great examples that relate directly to 
this question. 

Whatever the animal, you have to decide how humanised to 
make it. It needs to fit in with the tone of your tale or image. It’s 
a common convention to have animals walk on two legs that 
really don’t in real life. This requires compromising their 
anatomy. Animal Farm (traditional animation, 1954) has a 
combination of bipedal clothed and quadrupedal unclothed 
animals, but that goes with the tale. The armoured GC bears in 
The Golden Compass (2007) offer a nice example of how 
naturalistic and credible warrior animals can be. Obviously, my 
example here is far from photorealistic. Study images, film and 
reference books about the relative anatomy if you can get hold 
of them. Better still, try to study the live critter if that’s feasible.

Question
What should I consider when  
composing an epic landscape? 
George Kessler, US

Creating overlaps and 
complex layering could 
help to give extra depth 
to your images.

If you stand your creature 
up, try to convey the masses 
to reflect that you 
understand the 
anatomy of the 
real thing.

As well as making the animal 
itself work, the choice of outfit 

and weapons is important. 
These sketches look more like 

a train guard than a soldier.

Simple crisp geometrical shapes offer a hint that 
these hairdos might come from the future.

Use aerial or atmospheric 
perspective to show the 
differences between the 
scale of the objects.
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Question
What are the best 
brushes for 
painting skin?
Rakim Aiko, Japan

Step-by-step: Sorting your hair out

 I’m using Photoshop CS6 to execute 
this demo. In this image I sketch out 

the overall design of the hairstyle. I keep 
it to a very simple shape to give it that 
modern feel. Here I have chosen a 
diamond type shape that’s going to 
govern the overall design.

 I add the lighter values and colours to 
the hair and begin rendering in detail, 

slowly working on smaller areas until I 
begin painting in individual hairs. Even 
though I start rendering out details, I still 
make sure I don’t break that overall 
diamond shape I established at the start.

 I block in the light and shadow areas 
of the hair. I have chosen a natural 

brown hair colour for this particular 
tonsorial design. It is important not to get 
caught up in painting the individual 
strands of hair at this point and focus on 
blocking in the large areas.

Answer
Charlie replies

I think this all comes down 
to finding which method 
works the best for you. 
Plenty of artists have a 

specific set of brushes they use for skin. 
I tend to use very few brushes and keep 
things pretty simple. My favourite brush 
types tend to be hard edged and have a 
little bit of texture to them. I find these 
kinds of brushes to be very diverse and I 
can use them to paint pretty much 
anything: fabric, hair, and specifically 
here, skin. One brush I would absolutely 
avoid though is an Airbrush type.

It might be easy to fall into the trap of 
painting perfectly smooth porcelain 
skin, but it’s very unrealistic and can 
easily suck the life out of any character. 
You’ll end up with something very 
plastic looking. Using something with a 
bit of texture helps to emulate the skin’s 
natural texture and imperfections. Even 
if the texture is really subtle, it adds to 
the end result. It also helps with 
painting the planes of the face.

My preference is to paint in the main 
bulk of the face and not worry too much 
about detailing anything too early, like 
trying to paint individual pores for 
instance. As long as I’m using a hard-
edged brush, the general texture will 
come naturally. I then like to add in 
final textures towards the end.

At this point I’ve blocked 
in all the main features 
and contours of the face, 
and then I’m going to add 
in a few subtle textures.

A LITTLE MORE TEXTURE
Here I’ve used a 

Speckled brush on an 

Overlay layer and set 

it to around 10-20 

per cent Opacity. The 

speckled texture is great for em
ulating 

either pores or freckles without hand 

painting layers of dots. The randomness 

also helps it to look a little more natural.
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Question
How can you paint trees and foliage without it seeming flat on the screen?
Rasheen Anderson, Brazil

Step-by-step: Understanding the relationship between light and shade

low-hanging sun hits the planet with a 
strong side light. It’s used extensively in all 
three fields, partially because that side light 
casts long, descriptive shadows. 

Understanding the type of tree that you 
are painting, its trunk, its bark, and the 
shape of the leaves is all going to help tell 
the story as well.

Answer
Tony replies

I don’t mean to sound like a 
broken record, but the key to 
making anything three-
dimensional is descriptive 

lighting. When trying to understand form, 
the brain focuses on the relationships 
between light and shadow in whatever it is 
that you’re looking at. With this in mind, 
painting trees and foliage with depth is 
about understanding the shape of what 
you’re painting and then describing that 
shape with light – or the lack of it.

Choose a time of day and camera angle 
for the scene that have all the elements that 
you’re looking for, and make sure you’re 
closely using reference if any of this is new 
to you. Hopefully there’s a location you can 
get to nearby that has some trees that you 
can take pictures of to use as reference. But 
if not, I’m pretty sure that the internet will 
have a few pictures of them that you could 
use! ‘The Golden Hour’ is a phrase you hear 
a lot in illustration, photography and 
cinematography. It refers to the first hour of 
sunrise and the last before sunset, when a 

 Pay careful attention to 
silhouettes. A big part of 

how our brains recognise 
objects is by their outline, and 
the silhouette of a tree speaks 
volumes about what sort of 
tree it is. The texture and 
gesture of each plant is 
greatly influenced by its two 
dimensional shape. Using 
different sized brushes with 
different tip shapes help 
distinguish contrasting edges.

 Now that the shadows are 
in place, it’s time to start 

building up the light. Pay close 
attention to the direction of the 
light, and how reflective the 
surface of any given object 
may be. The way that the light 
hits it is what defines a tree’s 
volume. If it helps, imagine that 
the light source is a shower 
head, and everywhere the 
water touches is where the 
light shows up.

 With the shadow and light 
in place, the picture should 

start to take shape. The 
relationship between the two is 
central to the composition, so 
don’t proceed until you’re 
happy. Once everything begins 
to feel right we can move into 
more detail by adding in the 
darkest part of the shadows. 
Contrast tends to be softer in 
low-lit areas, so rendering isn’t 
as much of an issue.

 Edges are an often-
overlooked aspect of 

painting for newcomers, but 
considering your transitions 
will help bring out the depth in 
your image. If an edge feels too 
harsh, soften it. If transitions 
are too soft, try defining the 
edges more clearly. You can 
soften or sharpen with the 
Smudge tool, by changing the 
opacity, or with strict control of 
colour and value.

As usual, you want to start with a large brush and 
decrease size as you move into detail. Especially 
when painting trees, it’s important to alternate 
between simple and complex areas.

PUT COLOUR IN YOUR LIGHT

Almost all light has a colour tint to it, so 

keep that in mind whenever you are 

painting an illuminated area. The 

shadows are influenced by any secondary 

light sources, and tend to be 

complementary to the colour of the light.

Artist’s secret
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Answer
Charlie replies

I think the easiest answer 
to this is to make 
everything look as 
though it’s floating! That 

answer obviously covers a lot of 
ground, and there’s going to be a lot 
of variation in how a character floats, 
their pose and the situation they’re in 
– but it’s a good starting point. My 
character, for example, is in a very 
relaxed pose, and so I want it to look 
as though she’s floating serenely. So 
everything you can see here is 
floating, but in a subtle way. 

It’s difficult to depict 
weightlessness through a character’s 
body alone, but if you utilise the 
details like hair, clothing and 
accessories, it gets a whole lot easier. 
These are the details where you can 
really illustrate the lack of gravity – 
have a character’s hair or clothing 
floating around them, for instance. 
Just remember to keep things 

Question
How can I depict a sense of 
weightlessness in a character?
Mark Andrew Maguire, England

Question
Should I draw loosely or  
always refine my sketches?
Brian Wokes, Australia

uniform and paint everything with 
that sense of weightlessness – if her 
hair is floating and her clothes aren’t, 
for example, it’s going to look weird. 
If you have a character in motion, 
remember to make sure things are 
floating and trailing in the same or 
similar directions.

Question
How do I paint the light that’s 
reflected in a pair of glasses?
Diane O’Farrell, Ireland

Answer
John replies

The decision to create a 
loose drawing versus a 
tight drawing is usually 
defined by the 

information you want your drawing 
to convey.  If you want a lot of 
information with very accurate 
design and proportions and a lot of 
details and clear texture, then a 
tight drawing might be needed. If 
you want to capture the overall 
gesture and general silhouette of 
your character to get an overall feel 
for them, then something drawn 
more loosely that focuses on those 
aspects is what you go for. Usually 
when I have a character design 
figured out and want to know how 
the character looks when they are 
moving or expressing some sort of 
action, I resort to doing a lot quick 
and loose gestural sketches of the 
character doing things such as 
running or swinging their weapon.

Answer
Manon replies

Reflections on hard 
objects are easy to create 
without too many 
tricks. Once your 

character’s painted, create a new 
layer and choose either the Ellipse 
or Rectangle Tool to make the shape 
of glasses you want. Once you’ve 
made one lens, set that layer to 
Multiply and fill it with the desired 
colour. Now duplicate that layer, 

move the second lens next to the 
other, and drop both layers into 
each other. Use the Magic Wand to 
isolate both lenses, and use your 
brush on a new layer on top of that 
to add the reflections. Use a hard 
edged brush for the light reflections. 
For the rim of the glasses, use the 
Ellipse Tool with a thick line, and 
then slot in around the lenses and 
add the finishing light touches.

For the glasses I used the Ellipse tool on a 
layer set to Multiply, and copied the first 
lens so the two are the same size.

What self-respecting day walker from the 
1980s doesn’t finish off her look with a pair 
of tinted shades?

This image shows a few examples of 
character sketches that convey mainly the 
overall gesture and movement of their 
pose without too much detail.

This is a tight drawing that conveys a lot of 
specific information about the character, 
such as their expression and texture of 
their skin and body.

I think this character is 
pretty serene-looking, 
so I’ve tried to keep the 
weightless aspect of the 
painting fairly subtle, 
and possibly something 
you notice secondarily.

Don’t forget the details! Her earrings are 
another opportunity to add in that floating 
feeling – a smaller detail to help support the 
bigger idea.
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FAST, CLEAN SILHOUETTES
Use the Free Lasso tool. You create a free random shape on a new layer, and fill that selection with the bucket, or use a round standard brush with all the settings turned off, so when you paint the edges they are sharp and clean.

Artist’s secret

I find it easiest to 
paint light into the 
room as if the 
blinds weren’t 
there, and then 
erase away to 
indicate where the 
blinds are blocking 
the light. 

If you want the light to feel bright, make sure the rest of the room is dark. 
Without contrast, nothing feels particularly intense.

Here I conceptualise a huge ring  
of debris floating around a small 

planet in an imaginary solar system.

Question
Can you give me tips on painting a 
dynamic close up of a planet’s rings?
SpaceMonkey, US

Question
Can you help me paint light 
coming though blinds? 
Karen Choi, South Korea

I make sure to match the composition 
sketch. Now I paint the ring in the distance 
that wraps around the planet across the 
empty space we left. Remember that in 
space there is no atmosphere, so it’s possible 
to see illuminated objects at long distances.

I put the ‘sun’ under the layer of the 
foreground debris, paint the rim light onto 
the pieces of debris that are hit by the light 
(remembering the direction of light on the 
individual pieces). I apply atmospheric 
effects to the planet with some lens flare to 
give a final touch, then add a small 
spaceship in the foreground area to help 
give a better sense of scale to the debris.

Answer
Francesco replies 

The first thing I considered was 
the planet’s ring. What kind of 
debris made up the ring? In this 
case I decided that the ring was 

going to be made of asteroids of different 
sizes, spaceships and satellite debris.

I do some quick line drawings to block 
out the composition, then look for some 
cool references of planets in space, so I can 
understand how a big floating object looks 
in space where there is no atmosphere. Here 
I gave particular attention to how the star 
that this planet is orbiting lights the surface.

I start to paint the planet. I make it a hot 
desert planet without oceans, and I add 
some small lights that refer to a colony or 
city on its surface. I decided to make the 
planet take up two-thirds of the image – the 
rest of the open space is left to help give 
more depth to the concept!

Now I move onto the debris. The first 
things I paint are very clean and sharp 
silhouettes of rock, asteroids and random 
sci-fi parts in the foreground. I try to put all 
those dark silhouettes onto separate layers 
so I can easily move them around, make 
copies, scale them down or flip them so 
they can be reused to save time when 
creating a more dense ring of debris.

Silhouettes are a good way to create a nice 
contrasted realistic image. Once I’ve done 
that, the image is already 70 per cent done. 

Answer
Tony replies 

If you want to see dramatic light coming through a 
window, it helps to have a lot of dust in the air. Each 
particle absorbs a bit of the light, so the more there 
is, the more apparent the light beam will be. The 

way the dust floats makes some shafts of light look more intense 
than others, so try to ensure that the intensity isn’t the same in 
each beam throughout the image. 

Setting up the image is very similar to any other interior – just 
make sure that the window is your main light source. The blinds 
will of course be blocking some of the light, and how much they 
block has to do with how far open they are and what the angle 
of the light source outside may happen to be. Light shining 
through will be most intense when the blinds are open at the 
same angle the light is coming in.

How sharp the edges of your light beams appear to be is 
based on the strength of the light, the dust in the air, and how 
far the beam is from the source. Edges tend to be sharper near 
the window and blur as they move away from it. 
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Got a digital art problem? Is an image giving you art-ache? Our panel can help. Email your question to our 
experts at help@imaginefx.com or write to Artist Q&A, ImagineFX, 30 Monmouth St, Bath, BA1 2BW, UK.

Step-by-step: Suggest at negativity and anxiety

 I know roughly what I want, so I mark 
out some basic shapes in ArtRage 4, 

using one point perspective keyed to a 
vanishing point on a high horizon line near 
the top of the composition. The impression 

of looking down, 
puts the focal 
character below the 
viewer. Once these 
building blocks are 
in place, it becomes 
easier to place the 
figure in its space.

 I block in muted base colours using 
the Chalk tool, then build up tonal 

depth with layers of watercolour and a 
couple of flood filled Gradient layers, all 
set to Multiply mode. The flood fills are of 

different colours, so 
that by working into 
them separately with 
my chosen light 
colour (a cool blue/
white here) I can 
introduce variation 
and interest.

 I flood fill a layer with raw umber set 
to Multiply over the top, working back 

into it with my light colour again. To bring 
more interest/atmosphere and to suggest 
a dirty windowpane, I work through a 

Textural Stencil set 
up to cover the 
entire image surface. 
I make it obvious at 
the window but 
soften the effect the 
further away from 
the light source. 

 A combination of body 
language, viewing 

angle and elements 
composed around the 

figure to make him 
seem trapped all add  

to the atmosphere  
of oppression.

It’s useful to leave 
stencils in place so you 
can revisit them to perk 
areas up knowing it will 
fit in with what you’ve 
already laid down.

Question
How can I make someone seem 
oppressed in an everyday setting?
Dr Livingstone, England

Answer
Nick replies

Here is an image with a tang of 
George Orwell’s Nineteen 
Eighty-Four. Room 101 and all 
that. There are numerous ways 

to imply, oppression/repression/threat/
dread/foreboding/whichever particular 
blend you want. Making an image 
figurative immediately offers facial 
expression, clothing and body language to 
your arsenal. I’ve picked an every day cafe 
scene, but its retrograde style combined 
with dingy lighting and a general feeling of 
grime suggests a downbeat feel. You might 
prefer the opposite, with brilliantly lit but 
featureless surroundings – cold and 
dehumanised in a different way. 

I’m splattering clues all round this scene. 
Eye-level looking down: the main figure is 
hunched over, wearing a rumpled, bland 
suit without a tie, and peers out from under 
furrowed brow. He is pale and drawn, 
boxed in by straight lines, be they furniture 
and fitting edges or cast shadows. He sits 
alone. With everything else in relative 
shadow he is effectively spot lit. Exposed. 
Negative and controlling slogans adorn 
many of the surfaces around him. A 
shadowy figure in uniform watches him. 
Why is not explained. It all adds to the 
sense of threat to the individual figure. 

In the context of a sequential story you 
would not need to lay it on this thickly. In 
fact it’s often more effective to drip feed the 
clues over time to build tension. The thing 
to make the viewer understand that is a 
sense that the men here are not in control.
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LOST IN 
SPACE
Inspired by the international 
space race and a shifting 
public view of what science 
fiction could mean, a band of 
artists in the 1970s redefined 
the way we imagine space
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OF MOON STARS
John Berkey’s space art often 

depicted grandiose space crafts 
with loose brush strokes, as 
this acrylic on board piece 

from the 1990s shows.
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U
sing outer space as a backdrop to 

human drama has a suitably epic 
history. The term ‘Space Opera’ was 
coined in the early 40s to describe a 
trend in literature for melodramatic 
sci-fi action. Yet back in the 17th 

century, anyone who could read Latin 
could delve into the novel Somnium, 

which offered a tale of demonic trips to 
the moon. Projecting ourselves into the 
void has long been a human compulsion.

In the 1970s, this fascination culminated 
in a burst of visionary art that changed the 
way space opera stories were depicted 
forever. It was a reaction to several events. 
Stanley Kubrick’s 2001: A Space Odyssey 
propelled the sci-fi film into the realms of 
high art in 1968. This followed the work 
that the big three writers – Arthur C Clarke, 

Isaac Asimov and Robert A Heinlein – 
who’d been creating hard sci-fi fiction since 
the 40s. The international space race and 
the Moon landing was also fresh in the 
collective memory.

Commercial artists such as John Harris 
rode the wave of public interest in science 

fiction in the 70s. For him the 
appeal of putting the human 
stamp on space went to the 
heart of why he was an artist. 
“I cannot remember a time 

FOUNDING FATHER
In the mid-40s Chesley Bonestell 

(1888-1986) redefines the 
depiction of space with his 
photo-realistic paintings of 

Saturn from the viewpoint of its 
moons, using models and photo 

references to achieve a stark, 
beautiful vision of space.

DAISY, DAISY…
Outside of the growing 

sophistication of sci-fi book 
cover art, film concept art such 

as Robert McCall’s work for 
Stanley Kubrick’s 2001: A Space 
Odyssey inspires a generation  

to paint dramatic space 
scenes pregnant with 

human drama.

when I wasn’t physically and mentally 
stirred by ‘the vast’,” he tells us today.  
“I always felt it as a sensation in the body. 
Mentally, I associate it with the future.  
It filled me with electricity. This energy 
sparked off imagery in my mind that I 
wanted to share.”

And this imagery was new. After the 
Second World War, Chesley Bonestell’s 
remarkable art depicted space as it was – 
magnificent and isolated. His series of 
paintings of Saturn from the point of view 
of its orbiting moons (right) captivated 
people’s imagination. These paintings were 
stark and beautiful, but there was little 
room for humanity. 

Meanwhile, in the world of sci-fi book 
covers, aside from lone voices such as  
the visionary sci-fi artist Paul Lehr, 

PORTS OF CALL
Inspired by 
meditation, John 
Harris has long 
tapped into “the  
vast” to create 
awe-inspiring art.

 I felt ‘the vast’ as a sensation in  
the body. It filled me with electricity 
and imagery I wanted to share 

THE SIRENS OF TITAN
Here’s Chris Moore’s cover 
for Kurt Vonnegut’s novel, 
originally released in 1959.

THE OUTPOSTER
Peter Elson’s cover for the reprint of the 1971 novel places 
the viewer on the ground looking up, for added drama.  

John HarrisC

November 201340

SONIC 
BOOM

A warp-speed journey 
through 70s Space 

Opera art



SPACE 
MAN
Here’s a look into the painting 
process of the late John 
Berkey, who died in 2008

John Berkey came to 
prominence after creating 
a series of self-initiated 
paintings for 1972’s reissue 
for Ballantine Books’ Star 
series. In an excerpt from 

an interview in the Society of 
Illustrators’s book Magic and Other 
Realism, John explains how he went 
about creating his inimitable art.

“I generally make small colour 
schemes in tempera, looking for an 
interesting light source and colour 
combinations for the finished painting.  
I work seated and resolve the problem 
of being on top of the work with two 
mirrors: one reflects to a second one 
that I can see as I work. This enables me 
to see the piece from about eight feet 
without moving. It’s easier to see the 
space within the picture this way. Also, 
shapes are evident from a distance 
when not detectable close up.”

Amazingly, after John had finished his 
Star Wars art, he showed no interest in 
seeing any of the Star Wars films. He 
was resolutely all about the painting.

SHIP FROM DOWN UNDER
As well as original space opera 
art, John created art for the Star 
Wars and Star Trek franchises.

FEATHER SHIP
You can pick up a print of 

this painting on the official 
John Berkey site for $8,800.

END OF THE RUN
This 2001 original by John 
was originally used on a 
Japanese book cover. Now it’s 
one of the most dramatic 
covers of ImagineFX. A
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illustration and photography  
ruled the day.

BAND OF BROTHERS
Chris Moore and Jim Burns 
both left art college in the 
summer of 1972, and went 
straight to work. “Unlike Jim,  
I wasn’t a fan of science fiction at 

the time,” says Chris. “I always 
considered myself a jobbing 

illustrator, so we did a 
whole manner of things – 
Jackie Collins, Earl Stanley 
Gardner book covers, that 
kind of thing.”

Brian Sanders, a popular lifestyle 
magazine illustrator, who was tasked with 
drawing The Making of 2001: A Space 
Odyssey, saw the writing on the wall. “The 
1970s proved to be a challenging decade  
for every illustrator in Britain pursuing a 
career in magazine illustration,” he writes 
at his art blog (www.bit.ly/ifx-bsanders). 
“However,” he continues, “the market  
for paperback book cover illustration 
remained buoyant.”

In the UK in the early 70s, if you were a 
book cover illustrator and knew how to 
draw a spaceship, there was one obvious 
agency to turn to. “It was inevitable that 
when I showed people my work they 
recommended I take it to Young Artists,” 
says John Harris. 

Young Artists’ John Spencer and Alison 
Eldred had recruited a group of brilliant 

FANTASTIC 
PLANET
Peter Elson died in 1998, but 
his sister still champions his art

“Things started happening 
for Peter after he won first 
prize in Science Fiction 
Monthly’s painting 
competition in 1975. “This 
was his Fantastic Planet,” 

says Pam Elson. “It’s probably the only 
sci-fi original I have which wasn’t for a 
book cover. He then worked for various 
publishers, including Arrow, Sphere, 
Nelson, Orbit and Virgin, illustrating 
books by a great number of the major 
science fiction authors of our time.” 

MOTHERSHIP
Sci-fi art agencies, such as 

the UK’s Young Artists, 
represent distinct artists with 
a penchant for Space Opera 

art. With George Lucas’s  
Star Wars melding the 

enjoyment of Flash Gordon 
with the scope of 2001, Ralph 

McQuarrie’s concept art 
(above) adds fuel to the 

burning fire.

sci-fi artists, including John, Peter Jones, 
Jim Burns and Angus McKie. In the agency 
halls you might bump into Chris Moore or 
Chris Foss, both friends of the agency. It 
was a close-knit group. “In the 70s if an art 
director wanted a cover done he’d flip a 
coin on who he wanted to get, out of half a 
dozen of us,” recalls Chris Moore. “For 
monsters go to Les Edwards, Jim was very 
good at doing women and spaceships… 
that was the scene at the time.”

 For monsters 
Les Edwards, Jim 
for women and 
spaceships… that 
was the scene 

GENERAL 
PRACTICE
Digital concept artist 
Stephan Martinière 
has noted John Harris’s 
style as making an 
impression on him  
as a young artist. 

THE SIMULACRA
Once again, Chris 
Moore produces a great 
cover for a sci-fi classic 
– this time it’s Philip K 
Dick’s 1964 novel.

s Chris. “

ys Pam Elson. 

i
w

COMING OF AGE
Large-scale book cover 

paintings start to adorn more 
1970s sci-fi literature, including 

Larry Niven’s 1970 novel 
Ringworld, with art by  

Dean Ellis. The Ringworld mega-
structure concept would be 

revisited in the 21st century in 
Bungie’s Halo video games.

© Lucasfilm Ltd & TM. All rights reserved.
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FANTASTIC PLANET
This dramatic painting  

won Peter Elson first 
place in Science Fiction 

Monthly’s art contest, and 
launched his career as a 

book cover illustrator.
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FOR THE 
BENEFIT  
OF ARTISTS
For artists who daydream of 
outer space, it makes sense to 
have a relationship with NASA

John Harris, Chris Moore and Sparth 
have all been inspired by America’s 
National Aeronautics and Space 
Administration. For Sparth, it was a 
couple of formative years spent 
living at his uncle and aunt’s 
house in Cocoa Beach, 
Florida, near the Space 
Center in Cape Canaveral. 
“They both worked for 
NASA for decades,” he 
says, “so as well as seeing 
shuttles take off, talk was 
often space related.”

Thanks to NASA, Chris’s art 
crossed the stratosphere. Having 
painted the image of a commemorative 
2001: A Space Odyssey cover for limited 
edition stamps, he and Arthur C Clarke 
signed it and then sent it off into space 
for astronauts to sign.

For John, working with NASA was an 
inspiring yet eerie affair. In 1984 he met 
Arthur C Clarke and Freddie Durant III in 
Sri Lanka. Taken by his art, they 

suggested contacting 
NASA, and he was invited 

to document a launch. 
“The Shuttle launch was 

early in the morning,” he 
recalls. “The sun was rising 
immediately behind it. Within a 
minute of takeoff the shuttle 

had gone, and all that was left 
was a pall of vapour from the jets 

shrouding the gantry, with the sun 
shining through it. I fixed that moment 
in a painting (Aftermath T+60secs).”

The painting was sent to Washington 
in Nov 1985, but got stuck in customs, 
only released on 26 Jan 1986, two days 
before the Challenger Shuttle disaster.
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 Peter never knew his art 
was known in its own right. 
He would have been 
delighted and humbled 

LEGACY OF HEOROT 
This acrylic painting 
displays Chris Moore’s 
functional craft design, 
which is so important to 
the artist.

SKYLARKING 
Apollo 8’s Bill Anders snapped this 
image of the Earth from the Moon 
on 24 December 1968, and it still 
captures the fascination of our 
relationship with outer space. 

TAKE OFF
This painting by John 
Harris atmospherically 
documents one of NASA’s 
1984 Shuttle launches.

Space renaissance
Today, artists like Stephan 

Martinière, John Picacio and 
Sparth channel their childhood 

love of 70s epic sci-fi art to 
bring it into the digital age,  
for book covers, games and 
film. Artists such as Martin 

Dechambo (and writer Jeffrey 
Campbell) create the 

sci-fi space opera Project 
77 (shown here). 

Although the wave of inspiration 
they generated would build up for 
following generations to ride, this scene 
was for the time being limited to science 
fiction fans, today’s international online 
fan base being beyond even the greatest 
sci-fi minds back then. Pam Elson, sister of 
70s artist Peter, recalls: “As far as I’m aware 
he never knew his art was known in its own 
right,” she says of Peter, who died in 1998. 
“He would have been delighted and 
humbled to have known that.”
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“From eight to 15 I was an 
avid science fiction reader,” 
says Stephan Martinière, one 
of the most successful heirs to 
the 1970s art boom, “and 

many of the artworks from British artists 
were used for book covers at the time.  
I really liked Chris Moore’s technique and 
Chris Foss was a big influence on my art.”

But Britain wasn’t the only hotbed of  epic 
sci-fi talent. By 1977 Ralph McQuarrie had 
almost single-handedly created the look of 

Star Wars, the most lauded Space Opera to 
date. “Ralph’s was the Space Opera art that 
made me just as curious about the artists as 
the art,” says modern book cover illustrator 

John Picacio. “My mother 
bought me a folio of 
McQuarrie’s paintings for The 
Empire Strikes Back. His 
Cloud City of Bespin was on 

the cover. That was it for me.”
John Berkey produced early art for a Star 

Wars novelisation, and his dazzling style 

has become a favourite among artists. 
While Moebius had already laid the 
groundwork for Star Wars with The Incal 
comic in France, Berkey’s impressionistic 
style brought its very own drama and 
power. “John’s paintings are a kind  

of visual music,” says  
James Gurney, in Magic and 
Other Realism, “showing the 
power of abstraction to reach 
pure lyricism. Somehow that 

lyrical spirit fits perfectly with our dreams 
of exploring space.”

INFINITE APPEAL
Of course, there are contradictions within 
the term Space Opera (because it was 
originally coined to describe a broad trend 
in literature, not specific narratives). In 
film, many cite Star Wars as Space Opera’s 
zenith, but its fantasy heart niggles at 

others like Chris Moore and Sparth, who 
prefer a ‘hard sci-fi’ functionality to 

their Space Opera art. 
Of course, there’s room for both, 

as TV series Star Trek, Firefly and 
Battlestar Galactica can attest.
Growing up within spitting 
distance from NASA’s Cape 

Canaveral space station, Nicolas 
‘Sparth’ Bouvier talked a lot about 

space in his formative years. “It helped 

Continued on page 48

PEBBLE IN THE SKY
This Peter Elson cover for 
Isaac Asimov’s book was 
‘carved’ into the 
imagination of Halo artist 
Nicolas ‘Sparth’ Bouvier.

SATURN 2049 
John Harris’s 
influence goes beyond 
the sci-fi genre, 
thanks to his 
impressionistic style 
of painting. 

s Stephan Martinière,

John Picacio. “
y

James Gurney, in

BACK TO THE 
BOOKS

With video games like Halo and 
Mass Effect, space opera art is 
no longer the preserve of epic 
films and sci-fi novel covers. 
When it does adorn books, 

however, artists like John Picacio 
still get inspired by 
previous masters.
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DAVE SEELEY’S 
SP
Award-winn

A
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C
tist Dav

E AR
e Seeley uses his passi

IA
on for 

architecture, maths, and science, to inform his space opera
In his piece The Battle of 
Coruscant, created for the 
opening spread for Star Wars: 
Essential Guide to Warfare book, 
Dave Seeley used a totally 

unique approach to creating great space 
opera art – unique even for him!

NASA knows
1 “The Battle of Coruscant 

piece was initially created 
using NASA photography, and 
image grabs from the Star Wars 
Episode III: Revenge of the Sith 
Blu-ray depicting the scene. The 
image grabs were possible only 
because Lucasfilm owns all 
copyrights, and allows use of its 
intellectual property when 
working for them.”

Based on reality

2 “I overlaid two NASA 
shots, and stretched them 

into the two-page spread 
format I wanted. I then pieced 
together bits of the surface 
city lights from film grabs.”

Let battle commence 

3 “I then erased the blank areas 

. back to transparent cloud cover.  

d
ev I mined the film grabs for ships, and 

r
es collaged them into a composition that 

e
s 

r
t I liked, leaving the proper spot open 

h
gi for Anakin’s Jedi Starfighter.”
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Photo op

4 “My mission was to show 
this well-documented 

scene from an angle that we 
hadn’t seen before, so I shot  
a Starfighter toy, and chose 
my favourite angle within  
the composition.”

Fog of war

5 “Then I added the twirling 
missiles, laid in the title 

block, and sent it to my art 
director. After approvals,  
I printed the digital file on to 
archival paper, laminated it to 
a panel, and oil painted (the 
ships primarily), for a digital/
oil hybrid final painting.”

End result 

6 “I then photograph the hybrid painting 
for the final digital print file, just as  

I would for a traditional oil painting.”
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me understand what space was, and 
how man was slowly entering into its 
vastness,” says Sparth, “so my fascination 

with Space Opera art was 
rooted in hard scientific facts.”

Although art has since 
covered books by Jack Vance,  
Iain M Banks and James S A 

Corey, it was the artists of the 70s explosion 
that imprinted onto Sparth’s imagination.

“In the late 80s I saw Peter Elson’s cover 
for Asimov’s Pebble in the Sky [see page 45] 
– it’s still carved into my brain,” he says, “I 
also remember several Philip K Dick books 
with Chris Moore covers. I still have these 
images in my mind.”

For artists depicting ‘the vast’ today, the 
appeal is as varied as their styles. Dave 
Seeley gave up studying architecture for the 
star gazing. “By the time I drop-kicked 
architecture for making images, I had 
ingested a ton of sci-fi culture,” he says, 
“and it shaped the way I saw Space Opera. 
I’ve also loved watching the space 
programme, following the Apollo missions, 
and musing about where it might take us.  
I think space is inherently a backdrop and 

doesn’t obscure action. The view into the 
void, for me, is evocative of endless 
potential adventures.”

The digital age holds the key to 
tomorrow’s space opera art. “I’m an avid 
watcher of the Astronomy Picture of the 
Day that NASA put out,” says Chris Moore. 
“Everyday there’s a picture that’s something 
current – it’s fascinating. But of course, they 
didn’t have anything like that in my day.”

If you want a dose of that 70s inspiration, 
why not go to the movies. “Our influence?” 
asks Chris. “It’s for all to see in films.  

 I’ve loved 
following Apollo 
missions, musing 
about where it 
might take us 

THE UNINCORPORATED FUTURE 
Modern master Dave Seeley created this 
stunning digital painting for Dani and 
Eytan Kollin’s Tor-published novel.

ANGEL CITY
Growing up in Paris, Stephan Martinière was as much 
influenced by the sci-fi art of Moebius as Chris Foss.

Our stuff has inspired films for the past 30 
years. And that’s just timing. We were part 
of a movement when there was an 
optimism in science fiction. This idea of 
colonising other planets, the next frontier. 
It was like the Wild West and it burgeoned  
a colossal amount of imagination because 
there were no bounds. Everything was  
up for grabs.” 

EXTREMIS: 
STARFIRE
Continuing the 
tradition of dramatic 
space opera art 
adorning the latest 
sci-fi literature, Dave 
Seeley’s painting 
incorporates some 
model work by  
John Douglass. 

s Sparth, “S
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SHRAPNEL 3
As well as several book covers, 

Stephan Martinière has worked 
on films such as Red Planet and 

the big screen adaptation of 
Isaac Asimov’s I, Robot. 
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ON SALE NOW! Order your copy today at http://beta.imaginefx.com/shop

Learn to create amazing comic art in Photoshop, Manga Studio, SketchUp 
and more, using 12 all-new tutorials from the world’s leading artists!
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NEWS 
FROM THE 

HORIZON LINE ART
“A more developed line art 

drawing of one of the 
thumbnail sketches on  

page 54. Sometimes I scan the 
thumbnail on a computer and 

start refining the line art in 
Photoshop, and 

sometimes I prefer 
working with pen  

and inks.”

Tuomas Korpi
COUNTRY: Finland

Toumas is a 27-year-old 
production designer and 
illustrator from Finland. He 
has worked professionally 
in entertainment and VFX 

since 2005, and now has his own 
animation and illustration studio, 
Piñata. Most of the work he does is 
concept art or marketing illustration, 
and his clients include major VFX and 
gaming companies, individual 
directors and ad agencies. 
www.tuomaskorpi.com

Illustrator Tuo
mas creates concepts for marketing, so is a 

dab hand at sketchin
g quick concepts. See for y

ourself…
tor Tuomas creates concepts for marketing, skke
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THUMBNAIL 
EXPLORATION

“Some super rough thumbnails, 
exploring composition. My 

sketchbook is pretty much filled 
with this stuff. I try to always think 
of the big picture right from the 

start. Rarely do I go straight 
into drawing or thinking 

of the design.”

TREE AND A CAULDRON
“Just something more carefully rendered. I like 

to do this every once in a while.” 

MOLESKINE 
“Here is a set of sketches from one of my Moleskine 

sketchbooks. My sketchbooks are usually more like notebooks 
for scribbling down random ideas and madness than full 

of beautifully rendered and illustrated stuff.” 

VROUW 
MARIA

“A digital colour and 
lighting sketch for a painting 

of Vrouw Maria, a Dutch 
merchant ship in the 18th 
century. I usually start my 
more finished illustrations 
with these rough sketches 

to block in the lighting 
and key colours.” 

“I try to think of the big 
picture right from the start. 
Rarely do I go straight in”
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 NEWS FROM THE HORIZON THUMBNAILS
A set of thumbnails and composition studies that later 
became the painting News From The Horizon. I usually 
start out by making these small matchbox size sketches 

to explore the composition of a painting.

HOMETREE
“A base lineart for another painting I’ve 
been working on lately. This time it’s all 
digital, which makes it easier to change 

elements and rearrange 
composition.”

BEACH BAR THUMBNAILS
“A set of thumbnails and sketches for my beach bar image. 
I wanted to explore the volume and shape of the beach hut 

before moving into more detailed drawings.”
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BALCONY 
HAMMOCK 

“A more detailed drawing or sketch for 
this balcony sweetspot painting I’ve been 
working on. I feel doing the base lineart in 

a natural medium gives you a more 
natural or organic approach, which 

works great with certain styles 
or themes.” 

Want to share your sketches? Then drop us an email, with a selection of your artwork, to  
sketchbook@imaginefx.com, or upload your drawings at www.imaginefx.com/sketchbook.

GOUACHE 
STUDIES I

“A set of gouache thumbnails 
I did at our summer place.  

I haven’t painted much 
outdoors, but it was great 

fun and I should do  
it more.”

GOUACHE 
STUDIES II 

“Another gouache study from this summer. 
It’s always interesting to see the subtle changes 
in colour while you paint, and how the palette 

can vary and change depending on the 
movement, light situation and all the 

other variations nature has.” 

"I feel doing the base lineart in a natural 
medium gives you a more organic approach"
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Master the core skills of digital art with our team of professional artists. 
Featuring 117 bite-sized tutorials!

ON SALE NOW! Buy the print edition at http://beta.imaginefx.com/shop
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62 Give your concept 
art extra depth
Michel Donzé uses a 
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ILLUSTRATE AN 
EPIC ENVIRONMENT
Merge technological and fantasy elements into one epic environment 
with a technique that Thom Tenery likes to call photo-bashing

aving spent several years 
working in architectural 
design before making the 
transition to entertainment 

design, my approach to image making 
and the way I think about space is heavily 
influenced by my architectural education. 
I’m extremely interested in architectural 
history and historic period styles, so I 
naturally gravitate toward that subject 
matter regardless of the genre I’m working 
in. So with that in mind, this workshop 

1 The sketch
I begin with a loose indication of the overall idea. This is not a value sketch, but 

a diagram of the primary scene components: a temple portal cut through a wall of rock, 
a large staircase meandering up to the portal and a ship in the foreground.

2 Photo-bashing
The goal at this stage is to block the 

scene in with photographic material. Each 
time I paste a photo into the image I treat 
it using Filter>Noise>Median and set the 
radius to about 2 or 3. This knocks down 
the sharpness of the photos. I set the layer 
mode to Soft Light or Overlay depending 
on what looks best, and dial down the 
layer opacity. I use Image>Adjustments> 
Color Balance to key it to the shadow 
colour in the scene. I use Edit>Free 
Transform and Edit>Transform>Warp to 
stretch, scale, rotate and warp the photos 
into an interesting photo collage.

3 More photo-bashing
The initial photo-bashing process 

can look extremely messy. I’ll often have 
dozens of photo fragments at a dozen 
different scales, all with slightly different 
colour attributes and all superimposed 
in an ugly little collage. It requires work 
to get all of these parts and pieces to 
work together and feel like they’re 
occupying the same space. I use the 
Smudge brushes (included on the disc) 
to push value and colour around, to fill 
in areas around photos, and to paint out 
the edges of photo fragments. I’m 
keeping the contrast low and the lighting 
off at this early stage.

has given me the opportunity to merge 
both my architectural and my genre 
interests into one piece.

I’ll walk you through my image 
construction process and share a few 
short-cuts and time-saving techniques for 
environment creation. I’ll be pulling 
photos from past vacations to use as 
resource material for the photo-bashing 
part of the process. I’ll be aiming for epic, 
but I’m going to attempt to balance that 
‘epicness’ out with a human element.

I’m going to stage a scene where a ship 
has set down outside a remote mountain 
temple. We’ll see elements of advanced 
technology, and elements of fantasy 
living together. The ship’s pilot is meeting 
with a woman at the base of the temple 
steps, presumably on a mission of some 
importance. Since this is an establishing 
shot rather than a story beat centred on a 
character interaction, I’m not going to 
focus on the narrative beyond what the 
scenario implies tonally: a parting.

H
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Thom Tenery
COUNTRY: US

Thom has a
degree in
architecture
and studied
entertainment

design at Art Center
College of Design. He’s
worked on TV and film
productions and video
game development, and
has illustrated trading
card games and book
covers. His clients
include Universal
Pictures, Walt Disney
Pictures and Wizards of
the Coast. 
www.thomlab.com
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4 Even more photo-bashing
At this stage I’m beginning to tighten things up. When photo-bashing, be sure to 

make something new from the source material. Seize the opportunity to redesign it. I’m 
considering the shapes of the boulders and the graphic break-up of the wall of stone, 
and using the Transform controls to push and pull them into more designed shapes. 
I continue to stretch, rescale, rotate and warp the photos liberally. Everything is 
malleable when you’re working digitally. Don’t let the resource material enslave you. 
Make it serve the idea and the composition.

5 Altering the 
composition

I use Edit>Copy Merged followed by 
Edit>Paste to break off and relocate large 
pieces of the image. Along the way I use 
Edit>Free Transform to stretch and scale 
these pieces to manipulate their position 
and shape. I’m thinking about the overall 
shape statements at this point, and tuning 
the composition. I want the light graphic 
shape of the portal to be slimmer and 
taller and to adjust the positioning of the 
dark mid-ground element on the left. 
I want those big compositional decisions 
locked before proceeding.

6 Lighting choices
At this point I need to decide how 

I’m going to light the scene. I want most of 
the scene to remain in shadow, using the 
cool ambient lighting that I’ve already 
established. I’m going to have dappled 
sunlight falling across the boulders. Here 
is a quick lighting technique that I often 
use: make a new layer at the top of the 
layer stack and set the layer mode to 
Overlay. Select a warm colour (yellow) 
with less than 10 per cent saturation – 
almost white. Paint the areas where you 
want sunlight to fall with any fully 
opaque hard brush, and then soften the 
cast shadow edges using Filter>Blur> 
Gaussian Blur. This provides a convincing 
effect of sunlight illumination.

7 Adjusting colour and 
adding atmosphere

Image>Adjustments>Color Lookup will 
give you a range of colour adjustment 
presets. Use these to tweak colour and 
shift your palette. You’ll have to set the 
opacity of this adjustment layer between 
10 and 40 per cent to avoid overkill. You 
can layer up these Color Lookup 
adjustment layers to get more complex 
results. In this case I use Fall Colors and a 
couple of others to warm up the palette. 
After adjusting the colour I add layers of 
atmosphere with a soft, barely opaque 
brush, and silhouette areas against the 
background for greater shape clarity.

PHOTOSHOP 

CUSTOM BRUSHES: 
BLOCK_SMUDGE

DRYBRUSH

Set the Strength to 
about 98 per cent for
very opaque, graphic
effects, or dial it back to
around 80 per cent for a
more feathered look. Use
it like you would a rag in 
traditional media to push 
paint that’s already there 
all over the canvas.

Set the Strength to 
about 95 per cent to
achieve a very feathered, 
traditional media look. 
Use it like you would 
a large dry brush in 
traditional media to
soften edges and 
obliterate unwanted 
texture or detail.

Lock

Transparent Pixels
/ (PC & Mac)

Lock layer transparency 

without touching the 

layers window.

Color Lookup
In Photoshop CS6, go to
Image>Adjustments>
Color Lookup for a range 
of colour adjustment 
presets. Experiment with 
these to get unusual 
colour effects and refine 
your palette. It is added 
to your layer stack as an 
adjustment layer, so it’s 
non-destructive to the 
image. For the best 
results, dial the opacity 
of this adjustment layer 
back to less than 100 per
cent for more subtle and 
tasteful effects.
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8 Designing the ship
I block in a rough silhouette shape for the ship in the foreground and then lock 

Layer Transparency (/). Then I open up three to four photos of random objects: a 
computer mouse, a car, an airport photo and a techy-looking spotlight in this case. 
I paste these photos into the scene one at a time and place them on top of the silhouette 
shape. You’ll want to experiment with different layer modes like Overlay and Soft Light 
and reduce the layer‘s opacity for the best results. I use Edit>Free Transform and 
Edit>Transform> Warp liberally to distort, stretch and bend these photos until they 
resemble something interesting. I paint over them and use the BLOCK_SMUDGE brush 
extensively to manipulate the photos in an attempt to find the design. Add cutlines and 
other articulations until you arrive at something interesting. Follow the video on the 
disc to get an in depth look at how this process plays out. You really have to see it as it’s 
happening to understand the process.

9 Drone design
I design the drones by photo-bashing the work I’ve already done on the ship. 

Using the Lasso Tool (L) I select an arbitrary area of the ship and then Edit>Copy 
Merged followed by Edit>Paste. I use Filter>Distort>Spherize to balloon out the form. 
Then set the layer mode to Overlay or Soft Light for the best effect. Paint over it to refine 
the design using the same process that I used to create the ship.

10 Unexpected changes
I’m not happy with the rock wall 

that comprises most of the background, 
so I grab a different photo and completely 
replace the background using the same 
photo-bashing method discussed in 
earlier steps. It’s unusual for me to make 
such a huge change to an image this late 
in the process, but it just isn’t working, so 
I have to make the change. The image is 
better for it in the end.

11 Detailing 
and narrative

I make a detail pass, adding additional 
elements to fill out the world: smoke, 
atmosphere, birds, artificial lights, 
ground reflections, lanterns on the steps, 
vegetation and many prop elements. I add 
the foreground characters and the lighting 
around them. This piece is all about the 
environment, but I want to see some sign 
of narrative. It helps anchor the image, 
adds a human element, and provides 
something for the viewer to linger on.

12 The finish
I go to the top layer in my stack and Select>All. Edit>Copy 

Merged. Edit>Paste. This creates a flattened version at the top of the 
stack. Select any large soft round brush and a light yellow or orange 
colour (the colour of key light). Adjust the brush settings to 15 per cent 
Opacity and set the Brush Mode to Color Dodge. Now you can pop the 
contrast of the lights and warm up light areas like the large temple 
entrance and the lights falling across boulders in the mid-ground. 

Entourage
It’s helpful to have a 
custom library of simple 
character silhouettes on 
hand so that in 
environment concept art 
situations you can 
quickly drop a figure in 
for scale, or populate a 
scene with a few clicks. 
A dozen simple standing 
poses with some 
indication of costume or 
equipment saved as 
brush presets can save 
you a lot of time.

Group layers
Ctrl+G (PC)

Cmd + G (Mac)
Organise your layers by grouping them rather than merging them.

In depth Epic environment
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GIVE YOUR 
CONCEPT ART 
EXTRA DEPTH

Get the lighting right
Lighting starts from the idea of a 
fashion-show mood in a grimy wet alley. 
I chose a bright top-down street lamp 
as key light, making the skin stand out, 
while the bike’s technological details 
are lost in darkness. I also add rim lights 
behind to separate the subject from the 
background elements.

his image was commissioned 
by Applibot for its sci-fi card 
game Galaxy Saga. The brief 
was to show a pretty, long-

haired woman taking off her sunglasses, 
leaning on her futuristic bike. The bike 
had to be mounted with huge pulse guns 
on the side of the front wheel. She also 
had to look like a rebel with a good 
fashion sense, based on denim and metal 
bracers. Thankfully, this brief left a lot of 
room for design and personal 
interpretation of the character.

So what’s her life like? She could be an 
armoured memory-drug dealer, helping 

the powerful keep the alienated masses 
in the slums of the lower megalopolis 
addicted to ‘souvenir’. Maybe her fashion 
guise could be a foppish way to show her 
lack of interest in a world that doesn’t 
make sense. Maybe she thinks she’s 
helping her people by giving them the 
only accessible escape from a miserable 
reality. Would she be deadly? Or would 
it be an act? Or have I read too much 
Philip K Dick? 

But in the end, making up a story 
helped me to add the subtle believability 
which I always look for in a character and 
which keeps me interested. 

T

Michel Donzé shows how making up a backstory 
adds subtle realism to an initial character concept

PHOTOSHOP 

CUSTOM BRUSH: 
BRUSHESCOMPIL

I made a compilation of 
brushes I found online.  
I switch brushes a lot 
during my painting, from 
very basic ones to more 
rough textured ones. 

Refining shape  
and composition
The composition of a full body 
character on a bike in portrait 
mode is challenging. At the 
painting stage, it consists mainly of 
shape, value, sharpness and texture 
contrast (for example, the 
smoothness of the wet thigh versus 
the rusty detailed parts of gun) in 
order to guide the viewer’s eye 
through each point of interest.
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Focus on the look
Designing the character’s face is the difficult part. I want 
to make her look badass while keeping a sense of 
mysterious beauty. I find that a scornful expression of 
disdain brings asymmetry and interest, and the 
overexposed lighting could justify the vanishing of 
unsightly skin folds. I introduce the abstract-shaped 
earrings to generate more contrast and focus on her head.

2  Establish mass, 
mood and palette

Of course, the client picks the sketch for 
which I have no clear vision of what the 
final render could look like. In such cases 
it helps if, early on, I paint a quick rough 
to establish the general masses, mood 
and palette. This will serve as a guide in 
the rest of the painting process.

1  Concept sketches
After taking a few days to think 

about the brief – letting ideas come, and 
gathering inspiration and references –  
I usually do a bunch of sketches to send 
to the client. It helps the company have 
visibility early in the process, and helps 
me understand what it expects in terms 
of composition and overall design.

3  Adding colour
Now comes the time to draw a 

clean sketch of the bike and character, 
figuring out the design through a lot of 
trials and iterations, also making the 
bike and gun more imposing to contrast 
with the girl’s thin shape. I apply the 
mood, painting colours with a few 
highlights, before starting the endless 
detailing and rendering process.

In focus…

FLESHING 
OUT A 
CONCEPT

Build up form
Her latex glove is 
first painted with a 
grey diffuse rendering 
of the volumes. Then 
reflections and 
highlights, wrapping 
around the hand as a 
sort of varnish, are 
painted carefully on a 
middle Opacity layer 
with a Sharp brush. 
Finally, the pink line 
clarifies the volumes.

Artist insight Concept art
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PAINT AN ORIGINAL  
 ALIEN CHARACTER
Focusing on visual readability and storytelling to create his striking alien 
design, Keith Thompson explores the aesthetics underpinning it all

hat makes an alien character 
really feel alien? In this 
workshop I’ll show my 
process for creating an alien 

creature design. I’ll explain both the 
technical process and the concerns when 
designing something that feels alien to 
the viewer, but still has clear visual 
reasoning and a sense of narrative. 

I start with a pile of ideas that I find 
evocative and interesting, then whittle 
them down along the path of execution. 

1 Genesis
Probably the most important step 

is where I lose myself in imagining what  
I will be working on. I will close my eyes 
and daydream for prolonged amounts 
of time. A whole host of images, sounds 
and experiences are explored. Over time, 
these vague, hazy daydreams will solidify 
into something I could describe to 
someone, both visually and in a 
storytelling sense. Depending on how 
you find yourself working later in the 
process, the big decisions at this stage 
will define how the art takes shape, 
whether you are conscious of it or not.

2 The loose thumbnail
This is where the alien is first tested in reality. The general idea 

and forms are quickly sketched out at a small size. If I don’t react to this 
small doodle on an instinctive level I return to the previous step and 
come back to this step later. I do not explore multiple thumbnails in 
a sequential fashion, finding that it invariably simplifies designs and 
is a brute-force type of approach. I leave the automatic drawing to the 
Surrealists, even if it’s a tempting method for exploring an alien design.

3 The full drawing
As long as I am compelled by the flow and form of the thumbnail I will move 

on to the full size drawing. Maintaining an organic and living gesture is extremely 
important when moving to the full size redrawing of the thumbnail. I start with a 
harder lead and develop the line work further with increasingly softer leads. Get a feel 
for the types of pencils and papers that you like on a textural level – everyone should 
explore their own preferences. Some original core concepts from the imagining are 
apparent at early this stage, I am specifically drawn to the symbiotic nature of three 
entities joined together as one body.

It’s good to really roll your initial concepts 
around in your head – for a few days if 
possible. Ideas and visions that speak to 
you will persist over this time, and half-
baked ones will dissipate. Once those 
ideas start to really orbit each other in 
my thoughts it’s time to test them, but 
tentatively at first – I keep myself free-
flowing and explorative. 

I collect absolutely anything as 
reference. Colours and textures that 
seem otherworldly can inform a design 

as much as more literal things such as 
bizarre animals and mechanical objects. 
Remember that there still needs to be a 
discernible hierarchy to the weird and 
wonderful or it risks becoming an 
indifferent mush.

Keep in mind that when dealing with 
the alien what you’re usually seeking is a 
sense of strangeness. Different types of 
strangeness can seem threatening, gracile, 
vulnerable, sophisticated, or primitive 
without being overt.

W
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Script it!
When working on a large 
cohesive batch of 
designs – as this alien
creature would most
likely be a part of –
I initially create a few
action scripts that apply
processes that will be
repeated in each design
exploration. This saves
a huge amount of time
for a little front-end
investment, but more
importantly it creates
consistent touches that
will subtly tie all the
designs together.

HUD color picker

Shift+Alt+right-click (PC)

Ctrl+Option+Cmd (Mac)

Photoshop’s HUD Color

Picker has its drawbacks,

but it’s a quick and 

intuitive tool.

4 Scanning and cleaning
I take the completed drawing and scan it with every adjustment 

turned off in the scanning software. The surrounding of the alien 
creature is cleaned up digitally to bare white. The unadjusted scan 
leaves a faint grey texture within the body of the drawing. This 
textured grey gives a weight and denseness to the piece that will be 
worked upon in the later steps.

7 Colour washes
I create a new folder and set it to Hard Light. This folder contains the colour 

glazes that I’ll paint over the drawing. My first wash is an analogous gradient that 
imparts a subtle overall shift of colours, making a good basis to work on top of. I keep 
the general colour scheme homogenous and safe for the first stages of painting. I find 
that initial colour schemes can be traps if you’re not careful – you can dive headlong 
into colour but have trouble backing out. So I ease into what I imagined at the start.

5 Canvases
I collect some canvas backgrounds 

from my library that connect with the 
alien and its technologically advanced 
culture. I use a warm compound of paper 
and rust in Multiply layer over the line 
drawing. I delete the clean white around 
the figure, then float it over a backing 
frame for contexual support and recedes 
behind the elaborate creature design.

8 Distance
It’s a good idea to constantly zoom 

out, or even work zoomed out, of an 
image when laying in general colours. The 
whole piece is in view so any added hues 
can be gauged relative to the whole piece.

6 Adjust the values
I intermittently flip the piece horizontally as I work for a fresh 

view, and iron out any flaws or kinks if they become apparent. I flatten 
the cutout character and begin to paint with black in Multiply mode 
over the design to create areas of shade. I then use the Dodge tool set to 
midtones to add lighter values back in. In essence this is a continuation 
of the drawing process, and the entire focus is on line and value. 

9 Compounding
I can find it tempting to return to 

the value steps and go back to drawing in 
mono, but it’s a good idea to resist this 
until the painting of colours is completed. 
If your value work is detailed and textural 
it’ll seem to react with the flat one-colour 
glazes and add a complexity to them.

10 Go brave
At this stage I get more adventurous with testing my original vision of the 

colours. I leave the more eye-catching or contrasting colours to later in the glazing 
stages so I can view it against a more developed and harmonious relative scheme.
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Stick to stock 
tools for a job
I try not to overly
customise my digital
workflow (hence using
stock brushes). It forces
me to use approaches
that more resemble
traditional art media. It
also means I can work in
different locations with
ease. This applies to my
traditional tools, too – I 
use certain materials, but 
all I fundamentally need 
is paper and pencils.

11 Layering details
Here I start to apply markings and 

layered complexities to the design. 
Despite what I said about not returning to 
value drawing, this step does resemble 
drawing again in the markings and 
designs running over the alien carapace. 
In addition, I also begin to lay a graduated 
sheen of white over the transparent 
coverings on the faces set into the arms.

14 Flattening
I flatten the whole character but 

still maintain its separation from the 
background. I then return to more value 
work and use the Dodge and Burn tools 
(on differing settings depending on the 
quality and material of the part of the 
alien) to darken and highlight different 
areas of the character. It can be tempting 
to overwork this stage for added punch 
and vibrancy, but it can easily undo all 
the subtle work done earlier in the process 
if you are not careful.

12 Atmospherics
I pick up some of the colours from 

the canvas backing and then return to the 
creature’s body to apply some gradual 
glazes over the original glazes. I do this 
over areas I want to make recede from 
the viewer, or want to set back in space.

15 Ground plane
A base for the character to stand 

on can be as simple as a deft drawing of 
the character’s feet flattening out on an 
unseen surface. A cast shadow can work 
in addition. In this case I was tempted to 
further the aesthetic explorations of the 
alien culture and lightly painted in a 
fractured panel and branch network 
design over the ground plane. Finding 
a happy medium of how far to develop 
this touch is essential because I don’t 
intend to paint a full background or 
setting for the creature in this particular 
case, just enough to suggest something 
consistent with the cultural aesthetic I’ve 
already established.

13 Add ornaments
I continue to add design details to 

both the alien and the background. Both 
are intended as visual ornament as well as 
hints of the alien’s culture and aesthetics. 
Layering and harmony are important to 
any cultural motifs in a design, but avoid 
making these too analogous with the 
alien’s physiology unless you intend the 
cultural motifs to instead seem organic 
growths of the creature and its body.

16 Clean Up
I use the Clone Stamp to fix up any 

little spills and rough spots in the piece. I 
work very zoomed in and scour the whole 
artwork until I’m content with the details.

17 Completion
I actually ended up growing very 

fond of how the alien looked flipped 
horizontally, so I settle on this alignment. 
If a piece looks strange when flipped it 
can speak of a flaw in the visual flow 
of an image, and if you’re fond of both 
alignments you should be encouraged 
as you work through it. 
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DEPICT A GRAND 
FANTASY SCENE
Let an expert lead you through his thought process and provide tips on 
creating an epic fantasy environment. Levi Hopkins knows all the tricks

reating a fantasy environment 
can be one of the most 
exciting tasks as a concept 
artist. The possibilities are 

limitless as to what direction you can take 
your fantasy environment. However, this 
can be a double-edged sword, with 
anxiety setting in if you have no clear 
direction. I’ve had multiple projects, even 
on a day-to-day basis, where I reach high 
levels of stress with the demands of 
creating fantasy environments. The key is 
to practise constantly, listen to your peers, 
incorporate new techniques, and 
constantly observe the environment 
around you to inspire you in your work.

In this workshop I’ll demonstrate 
some of the thought process and direct 
techniques required to help overcome 
some of the obstacles involved in creating 
a fantasy environment.

C

In depth Grand fantasy scene
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1 The beginning
The beginning of any concept can 

be the most daunting aspect of its 
creation. To tackle this problem I have a 
series of steps I follow religiously. If I fail 
to follow these steps I can almost 
guarantee a very, very long, restless night 
and a very annoyed wife. For the first step, 
I look through all the reference that I’ve 
collected over the years. I have one giant 
folder full of photography of my own or 
that I’ve collected from the web. Once I’ve 
found a few images that strike an emotion 
with me at that moment, I move forward.

2 The 3D stage
For this workshop I decide to not block-out a scene in 3D, but to 

create a 3D mesh that I could then render out and incorporate into my 
concept like a custom shape or texture. To do this I could use any 3D 
program (here I’m using 3ds Max), and begin to model out basic shapes 
while keeping in mind the reference I’ve found for inspiration. I decide 
to create a bunch of wood scaffolding folding into interesting shapes. 
Once I’ve got some scaffolding modelled out, I render out a basic view.

3 Creating the mask
When using 3D in a concept I always remind myself of helpful 

techniques that can speed up my painting process. When I render out 
my scaffolding piece, I remember to save the image in Targa format. 
Targa images are 32-bit and come with an alpha channel – essentially 
a cut-out mask that can help you move the image around in your 
Photoshop file. You can find the alpha channel of the rendered image 
under the Channels tab in Photoshop.

4 The renders
Now that I have a basic model, 

I like to rotate around it looking for 
interesting viewpoints. At this moment 
I don’t have a clearly defined agenda for 
my painting, so I like to keep things loose 
and hope for happy accidents. A good way 
to achieve happy accidents is to just 
experiment and take risks. With this in 
mind I just render out additional angles 
of my 3D model – whether I use them or 
not, it’s worth the extra time.

5 The painting begins
Now I’ve completed all the renders, 

I move on to the fun stuff. I like to wipe 
out the white canvas in Photoshop, so 
I take an old painting and run a Motion 
Blur filter on it with Filter>Blur >Motion 
Blur. This distorts any detail, leaving an 
abstract image with an interesting palette 
and values. I’m still in the experimental 
phase, so I don’t worry about any total 
commitment to what’s on the canvas.

6 Breaking the 
abstraction

Adding some detail to my abstract canvas 
can define the area. There are many ways 
you can achieve this in Photoshop: add 
brush strokes, textures, custom shapes or 
old paintings on layers. Here I decide to 
use the Clone Stamp and sample some 
areas my reference. I like to do this on a 
layer above the initial painting and lower 
the opacity. You can use any of the layer 
modes by cycling through with the up-
and-down arrow keys just in case you 
stumble upon a happy accident.

PHOTOSHOP 

CUSTOM BRUSH: 
SQUARED

Stop painting with round 
brushes – use square 
shapes to snag a better 
angle stroke.
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9 Transform more
I’ve got a ton of layers with the 

renders I created bent into a variety of 
shapes. I keep pulling from this library, 
blocking in different areas of the image. 
I imagine a larger mass of scaffolding at 
the top of this rock, potentially imitating 
some sort of aquatic life. I create this 
shape by using Free Transform (Edit>Free 
Transform), offsetting the pivot point, 
then replicate and scale copies of the layer.7 Searching for a trigger

This is the favourite point of any 
painting for me – the point where 
exploration opens up your mind and you 
begin to add and subtract, push and pull, 
and search for something that triggers 
your mind. I loosely add some brush 
strokes to start breaking up the open 
space. I also quickly block in a few scale 
figures with absolutely no commitment 
to their placement. The reason I do this is 
to help my mind start picturing the scale 
of the environment I’m creating.

10 Back into balance 
The image is feeling a bit lopsided 

to me at the moment. There’s too much 
weight on the left side of the canvas, with 
the rock and large scaffolding structure 
being built on it. I alleviate some of this 
lack of balance by just taking the rock 
layer I created earlier, duplicating it, 
scaling it, and then moving it around the 
canvas until it reads right to me.

8 Adding shapes to the scene
With the few elements I’ve added so far I begin to get a mental image of where 

I want to take this piece. I now start bringing in the 3D renders I created earlier and use 
them pretty much like custom shapes. When I first drop them in, I tweak their 
appearance a bit with Color Balance (Image>Adjustments>Color Balance). This enables 
them to mesh more closely with what’s already been created. I then take the newly 
adjusted renders, which are on layers, and use the Warp tool (Edit>Transform>Warp) 
to bend and push them into perspective.

11 Introduce depth
I want this image to have a bit 

more depth to it, and one of the best ways 
to achieve this is to repeat an element into 
the distance. I decide to take the newly 
created large scaffolding mass at the top 
of the first rock and duplicate that layer. 
I then move that layer, scale it down, 
rotate it and attach it to the rock in the 
middle of the canvas. The initial values 
have too much contrast, so I take the layer 
and adjust the saturation (Image> 
Adjustments>Hue/Saturation), using the 
Lightness slider to pull out the blacks.

Adjustment 
layers
I use a ton of Adjustment 
layers in Photoshop. One 
great technique is to hit 
Ctrl+G to group any 
number of adjustment 
layers you have in your 
file. Once they are 
grouped together, I click 
the Add Layer Mask 
button, which will add a 
mask for the entire 
group. From this point, 
feel free to paint out 
some of the effects 
created by your 
adjustment layers.

In depth Grand fantasy scene
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Clone Source
The Clone Source panel 
is a great opportunity to 
explore the wide variety 
of options available for 
either the Clone Stamp 
Tool or Healing Brush. 
You can open the Clone 
Source panel by going to 
Window>Clone Source 
in Photoshop. Within this 
panel you can rotate 
your sampled area, flip 
it horizontally and 
vertically, and scale it 
up or down.

12 Greater cohesion
I realise the environment needs a 

bit of unity. One of my favourite methods 
for achieving that is by using adjustment 
layers. Don’t be afraid to experiment 
constantly with this. One I use on this 
piece is a Curves adjustment layer. Within 
the Curves dialog I drop down through 
the different channels available (Red, 
Green, Blue) and tweak the values 
separately. By doing this I create a bit of 
harmony and pull everything together.

15 Healing brush
Having the painting on one layer 

enables me to use some cool tools in 
Photoshop. One of my favourites is the 
Healing Brush. With this great tool you 
can Alt-click to sample any area of your 
painting. You then can take that sampled 
area and paint it on top of another area of 
your image. Photoshop then blends the 
two together, sometimes giving you nice 
effects. For this piece I sample the open 
sky and then paint it on certain areas to 
soften the image.

13 Group elements
Now that I’ve got a good set of 

adjustment layers pulling the image 
together, I place them all in a group with 
Ctrl+G. With this group of adjustments 
you can do a variety of things. You can 
add a mask to the entire group and paint 
out the effect it creates in some areas of 
your painting, you can lower the opacity 
to lessen the overall effect, or you can 
turn the visibility of the group off and 
continue to paint below that layer, then 
turn it on later to bring back the cohesion.

16 Enhance the lighting
I’m rapidly heading towards the finish line for this painting. At this stage I like 

to hop around the image adding small details and brush strokes, and push the depth 
between the layers. I notice it needs the directional light to be a bit stronger. I decide to 
add this with a layer set to Color Dodge and then paint a lighter value over areas of the 
painting, simulating light. And then I call the image finished! 

14 Image manipulation 
Once I’ve pushed a painting quite 

a way, I like to create a ‘stamped’ layer, 
merging the whole image together but 
without losing the layers. I’ll sometimes 
leave some of the layers that were created 
below the complete merge to use them as 
masks later in the painting. Once I’ve 
merged the whole painting together I like 
to take entire chunks of the canvas and 
free transform them. For this piece I take 
the large structure on the left and push it 
a bit more into perspective.
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Mix your art techniques to 
great effect, with the help 
of our workshop artists

SAVE 36 PER CENT OFF THE COVER PRICE  
OF IMAGINEFX. SEE PAGE 78 FOR DETAILS

Mi t t h i t

Raise your 
art game

ISSUE 102 ON SALE IN UK 11 OCTOBER 2013

Even more help 
& advice!
Check out our brand 
new section devoted 
to teaching all forms 
of traditional art.

Unique horror 
portraits  
Lauren K Cannon  
uses Photoshop and 
Painter to produce an 
engaging composition. 

Starting out  
in Illustrator 
Tom Mac shows you 
how to create a family 
crest with the use of 
Adobe Illustrator. 

Take a spin of 
the colour wheel 
Make the best use  
of complementary 
colour schemes with 
Christopher Burdett.

Inspiring advice
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Daren Bader reveals what inspires 

him to paint his gritty fantasy art 

www.darenbader.blogspot.co.uk



DESIGN A SPACE 
OPERA CHARACTER
From the initial rough concept to its flawless execution, discover how  
Devon Cady-Lee develops a character that fits the Space Opera genre

pace Opera is a difficult thing 
to properly define, and that’s 
why I love it. Perhaps these 
days it’s easy for anyone to 

separate fantasy from science fiction, but 
once upon a time (a time long before we 
physically sent humans into space), the 
thought of living on another planet was 
a much greater mystery. I really enjoy 
looking back at the unique time before 
these genres were so well established. 
There isn’t a demand for storytellers to 
explain how technology works or obey 
the laws of the natural world – the 

1 Getting started
For this workshop I shall be 

working in Photoshop, at an image size of 
about 5,000DPI lengthwise. I feel this 
resolution is just about adequate to get the 
level of detail that I want without killing 
my machine in the process. I intend to 
only really use the History, Layers, Tool 
Presets and Navigator windows in the 
execution of this image. I have my 
character-related layers and my 
background-related layers grouped 
separately; this will save me time when 
I want to see the character without the 
background, or vice versa.

2 Eyes on the prize
I decide to illustrate a Captain of 

the Guard. I’m not a great planner, but I’m 
comfortable repainting anything that 
looks wrong no matter how far along I 
get. I start making marks to get a sense of 
the general composition and posing.

audience simply accepts these realities, 
much like in any fantasy tale… But this 
time it’s in space! 

They’ve got romances, feudal wars, and 
epic journeys to exotic locations – all with 
lasers and spaceships. In contrast to other 
genres of science fiction, there is a strong 
emphasis on values that have lost their 
glamour in the modern age; ideas of 
tradition, a code of honour, chivalry, and 
so on. Space Opera tries to bring these 
values back, and attempts to show that 
they are relevant, regardless of time 
passing, no matter how far into the future.

So my prime directive with this 
workshop is to make a Space Opera 
character. This implies that I need to 
create a whole world to accompany the 
character itself. Using a few visual queues 
and conventions that come with the 
territory, I can tell a story through 
imagery. I draw inspiration from classic 
space operas like Star Wars, Princess of 
Mars, Amazing Stories and Dune. I also 
look to the work of Orientalist illustrators, 
because they are a fitting inspiration for 
anybody who is trying to capture the 
allure of a foreign world.

S

3 Let the brush 
serve you

I use a simple array of brushes to paint 
with, all with Pressure Opacity. For this 
image I’ll use a hard round brush (which  
I use to sketch and paint delicate things); 
a Chalk brush (which I use for most of my 
rendering); and a Chisel brush (for planar 
work like buildings). What’s most 
important for me is to use something that 
can give me a hard edge on the sides, but 
blend more evenly in the middle.
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2006 and has produced 
concept and illustration 
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RPGs, card games, FX 
studios and film.
www.bit.ly/cadylee
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Adjustment 
Layers 
I always experiment with 
Adjustment Layers to 
see what I’m missing. 
Taking out the saturation 
helps me see my value 
mistakes, and playing 
with Color Balance 
helps me see what’s 
missing in my range.

Toggle tools

Shift+any tool (Mac & PC)

This will cycle through all 

the tool variations. This is 

especially useful when 

using Dodge and  

Burn alternately.

8 Funny hats
Elite guards and armies of the king 

always have distinct costumes and 
headware that aren’t really functional, but 
serve to stand out and put them higher 
than normal soldiers. I take inspiration 
from historical warriors to combine them 
into a culture that is uniquely my own. 
Space Opera is fun for me, mainly 
because I get to design new cultures!

6 Concepting  
the character

I want to make a bold, solid silhouette 
with my character’s cape to imply her 
position of order and power. I give her a 
pose that includes a half-drawn sword, 
which is explicitly a sign of tension and 
wariness. I make sure this is reflected on 
her facial expression, using parted lips 
and alert eyes.

4 Juggling act
Often I try to concept a strong 

design before posing and lighting it for 
the illustration, because doing both at the 
same time is difficult. I keep the pose 
simple to focus mainly on the costume. 
The background will exist only to support 
the character. I paint very opaquely in the 
beginning to get a sense of my flat shapes, 
and then blend with lighter strokes. 

9 Some context
I play a lot with the background 

throughout the rendering to see what 
shapes give a nice flow. I’m trying to 
establish a fore-, mid- and background, 
and try to keep her face from being dead 
centre. I wait until I have a clear camera 
angle to start checking perspective. I also 
imply some building shapes for context.

7 Storytelling  
with shapes

To convey a sense of the warrior, I make 
sure she feels aggressive with sharp shapes 
along her silhouette. However, I choose to 
decorate her with softer, round shapes 
closer to her face so she doesn’t come off 
as malevolent. The power of shape design 
can tell a story without words.

5 Make it clear
The lighting needs to complement 

my design, so I choose it to be sunlit from 
the front and above her for clarity. The 
background is there to draw the eye across 
the design and not steal too much 
attention while remaining interesting. 
The theme is the power of the character; 
all my judgements revolve around this.

November 201376

Workshops

5 T
d i

9 I 
h

4 O
sign

6 t
ant t

7 w
on

8 F
E

ys h



Finishing 
touches
Keep Navigator open so 
that your drawing 
remains in perspective. 
Take a snapshot and flip 
it to see rendering errors. 
Ask any friend, artist or 
not, what they see. It’s 
important to get fresh 
perspectives while you 
paint in order for you to 
see your mistakes.

Paste in place
Shift+Ctrl+J (Mac)
Shift+Cmd+J (PC)Copies your selection and pastes it into a new layer in exactly the 

same spot. 

16 Final touches
Keeping the lighting and colours 

consistent is important for making the 
character feel as though they are a part of 
the environment – although I do fudge 
them to my discrepancy. I prefer to merge 
down my adjustments before I start 
painting on the layer again so it doesn’t 
become a headache. 

15 Keep it together
I make sure to make my cast shadows feel consistent, as well 

as bouncing colours off of one another to define their relationships. 
I sample colours from the sky to reflect off her skin and cape, and the 
ground colour bounces off from the side of her boot. New patterns, like 
the tiling, can’t overpower the rest of the image.

14 All about feeling
Material definition is extremely 

important when explaining a new 
concept, and in this illustration it’s no less 
important. I make most of the materials 
very familiar, and I even make the metal 
elements feel old. I only make a few 
tweaks to the construction of her outfit 
that really imply that it is science fiction; 
I don’t especially want to go overboard 
with explaining function.

13 Not in Kansas
We need some Space Opera 

conventions. How about a battery-
powered sword? A breathing tube to filter 
her air? Spaceships? Weird, double-
mooned skies? I’m fitting them all in. I’m 
making it clear this is not Earth, that she 
is well adjusted to her environment, and 
that the only alien here is you.

12 Stage treatment
It’s becoming clear to me I need to 

start caring about the background. I create 
a simple perspective grid by drawing lines 
across my image horizontally, and then 
I modify them with Perspective Warp. 
Next I use a line grid to define my 
horizon line and keep it in mind at all 
times. I can use shapes in the architecture 
to start relating to my character.

10 Support the character
I change her footing to appear as 

though she’s stepping off of the stairs 
behind her, in order to make her feel like 
she’s heading towards the viewer. This, of 
course, adds more tension. I render the 
cape on her left side to come towards the 
viewer a bit, again drawing them in. I’m 
adjusting elements to fit the story that  
I’m trying to tell as I go.

11 Layer management
I’m constantly making new layers, 

but I merge them down when it’s time to 
move on. As a general rule, I just don’t 
want to have to extend my whole layers 
tab to the bottom just to see them. I also 
name the important ones that I always 
return to, and group them when I feel 
there are too many to manage. 
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Buy rare editions & 
the latest issues of
DIGITAL EDITIOONNSS  SSingleingle issues: issues: £4 £4.9.999/$/$6.96.999//¤¤55..4499

Download and read the latest 
edition of ImagineFX on your 
smartphone, tablet, laptop or wwhhililee  
sat at your computer at homee..

iPad, iPhone  RRaarre ee ed

Pod touch*ch* 
itions (including

and i
 iisssusueess 1 1-7,) are available at 

www.bit.ly/ifx-app wwwww .zinio.com/
*You’ll need iOS 4.3 or higher. iimmaga inefx-single

Google Play 
www.bit.ly/maggooglee

Android, tabletts W Nle s  WAANT TO 
and desktopss SUBSCSUBS RIBE?
www.zinio.com/ DIGITAL EDITION 
imaginefx-single P50 AND P56
Nook PRINT EDITION P28
www.bit.ly/ifxnook iPad is a trademark of Apple Inc., registered in the U.S. and other countries. App Store is a service mark of Apple Inc.

PLEASE NOTE: : DDISISCC  CCOONTENTENTNTT IS NO IS NOW W IINNCLCLUDUDEDED WITH WITH D DIIGGITITAALL ED ITIONS*
*D*Diissc cc coontnteennt it is available from issue 85 onwards. 

PRINT EDITIONS Single issues (incl. delivery): UK £5.99, Europe £6.99, Rest of world £7.99

Issue 95 May 2013 Issue 96 June 2013 Issue 97 July 2013
Manga and mechs make Immerse yourself in the How could ImagineFX 
up a large portion of this world of classic fantasy not celebrate the 50th 
month’s cracking issue. art with the help of John anniversary of Marvel’s 
Our packed workshop Stanko, who channels X-Men, or 75 years of 
section will give you the the skills of Frazetta to DC’s Superman, in this 
skills to compose manga produce this month’s month’s comic special 
fight scenes and heroic stunning cover. Our issue? And with 
characters, and explain workshop artists will workshops on mood 
the secrets of manga’s also help you depict lighting in your comics, 
masking techniques. moving fabric, paint a how to pose two heroes 
And we discover what it magical forest and give and beating creative 
takes to paint the your digital paintings a block, you’ll soon be a 
perfect mech. traditional feel. digital art superhero! 

Issue 98 August 2013 Issue 99 September 2013 Issue 100 October 2013
Be inspired by Simon To celebrate Magic: The Our bumper 100th 
Dominic’s monstrously Gathering’s 20th anniversary issue looks 
good cover art, then birthday, we talk to back to our past, and 
discover how paleoart some amazing card-art casts an eye over the 
has evolved over the artists, such as Jason artists of the future. 
years, as we talk to  Chan, Scott M Fisher There’s a countdown of 
the artists who paint and John Stanko, while your 100 greatest artists 
dinosaurs as realistically workshop artists include of all time, a review of 
as possible. Workshops Aleksi Briclot and Volkan your favourite covers, 
from Katie De Sousa and Baga. Elsewhere, Sparth plus workshops from 
Weta’s Christian Pearce ‘sculpts’ a sci-fi vista and Jason Chan, Raymond 
also riff on the Lost Dave Rapoza paints a Swanland and the 
World theme! dark, brooding scene. mighty Genzoman!

Visit www.bit.ly/ifxbackissues Phone +44 (0) 844 848 2852
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GETTING TO KNOW 
PROCREATE’S 
SELECTION TOOLS

Procreate stands out because of its versatile yet restrained toolset. The 
latest version adds more masking flexibility, as Paul Tysall finds out

1 Creating a selection 
Start by selecting the S-ribbon icon 

from the top left of the menu bar. There 
are two methods of creating a selection 
in Procreate: you can draw a continuous 
line (Freehand) or you can tap from point 
to point (Polygon) – or you can use a 
combination of both. You can still use the 
Undo and Redo options at this stage, in 
case you need to go back and alter the 
path of the selection. To close it, tap the 
blue start node.

2 Making a mask
At this point you can activate 

the Mask mode by choosing the Paint, 
Smudge or Erase tool. Or you can tap the 
Plus and Minus icons on the sidebar: the 
Plus icon will leave the pixels inside your 
selection active, while the pixels outside 
remain dormant – indicated by a series of 
diagonal moving lines. You can still create 
further selections at this stage using the 
Plus and Minus icons to refine your mask.

3 Extra features
Some additional selection features 

to note include masking from a target 
layer. So if you already have an overall 
shape of your subject on one layer you 
can choose ‘Select layer contents…’ from 
the pop-over panel to generate a mask 
from it. You can also use the Selection 
tool with the Transform settings to  
isolate parts of an image to be distorted. 
Procreate also remembers your last mask 
– simply tap and hold the Selection icon 
to activate this. 

to Procreate, working seamlessly with pan 
and zoom gestures to maintain workflow. 
Furthermore, you can add to a selection 
and subtract from it as you go along, and 
even select outside the canvas area. 

Beyond masking, the tool makes it a 
lot easier to isolate a specific area so you 
can use Procreate’s Transform tools – 
handy for correcting any perspective or 
proportion mistakes. Let’s take a look…

ith version 1.8, Procreate 
artists can now mask areas of 
a painting with the Freehand 
Select Tool. In traditional art 

this was done using masking fluid; in 
airbrushing and photography a film was 
applied. Photoshop has several masking 
features available to digital artists. In 
typical Savage Interactive style this 
feature is a simple but powerful addition 

MASKING WITH 
FREEHAND SELECT

A. Freehand Select 
Tool icon
Tap here to begin using the Selection Tool.

B. Plus icon
Select this to add to your selection.

C. Minus icon
This will remove pixels from your active 
selection area.

D. Remove icon
Tapping this once will remove your current 
selection. If you have a mask already active, 
which you were adding to or subtracting 
from, then a second tap will remove the 
entire base mask.

E. Invert icon
This will invert your mask area, so what was 
selected is deselected and vice-versa.

F. Starting Node
This blue circle indicates your start point – 
tap it to close the path.

G. Active Selection
These ‘marching ants’ denote the outline of 
the path you’ve plotted.

H. Actions
You can also set the mask’s opacity by 
going into the Actions settings – navigate 
to Prefs and use the slider to achieve the 
desired visibility.

3 S
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After four
years as
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art world, Paul is now a
busy freelance designer
and illustrator. 
www.tysall.com



USE REAL 
REFERENCE TO 
DESIGN AN ALIEN
Peter Stapleton explores the new features of Corel Painter X3 to design 
a cute but tough alien, using some unlikely reference along the way

he design of an alien is really 
only limited to your 
imagination, but borrowing 
from nature is great for 

making a believable creature. I want my 
alien to feel lovable, but I’d also like it to 
be tough and believable.

I immediately thought that a frog 
would be a great jumping off point for the 
design. The slimy, scaly texture of frog 
skin is perfect. Before I start, I decide to 

1 Line art start
I create a few thumbnail sketches 

to get the creative juices flowing. They’re 
quick and really messy, but I make sure 
the silhouette and design are interesting. 
Adding cheekbones, a brow and an eye 
shape similar to a human is a good way of 
keeping them relatable. I experiment with 
different shapes, enlarge and stretch 
different elements, add horns, scales, 
bumps, lines to see if anything looks 
good. I choose a thumbnail to refine.

3 Froggy colour
Now it’s time to choose my colours. 

I use the new Reference Image feature in 
Painter X3 to have photos of frogs to look 
to when I need. There were a couple of 
frog colours that really caught my eye, but 
I really like one that has a bright saturated 
orange with a yellow highlights. The eyes 
had to contrast with the skin so I chose a 
desaturated grey. I wanted the head to be 
the centre of attention so I paint the 
clothes with more muted colours.

2 Value mock-up
Here, I put the line art on a 

Multiply layer and create another layer 
underneath to do a quick value painting. 
I know I want to have a warm atmosphere 
in the final painting, so I paint everything 
in a warm tone. I’ve decided to have a rim 
light coming from the top right of the 
image and another coming from the left. 
I do this quickly, as I know that I’ll be 
able to apply much more accurate light 
later on down the track. 

gather some reference photos of a variety 
of frog breeds. The alien needs to be 
designed to be cute, so I need to think of 
the necessary elements. Big eyes, soft 
features and a lack of sharp pointy bits are 
a sure fire way of keeping things cute. 
Frogs are cute – at least I think so.

I’ve decided to keep him 
anthropomorphic and give him some 
futuristic gizmos to keep with the 
futuristic, sci-fi, alien theme.

I feel that putting him in a bar with a 
bunch of ne’er-do-wells would be a 
suitable environment to showcase his 
talents. Here his cute aspects will conflict 
with the inferred aggression of the scene. 
I still need to make sure that he is the 
centre of attention, though. 

In this workshop I get to use the latest 
version of Corel Painter – X3 – for this 
painting, so I’m excited to use the new 
features to speed me along.

T

Brush tracking
Be sure to adjust
Painter’s Brush Tracking
setting. This greatly
affects the way it feels
when you paint. Play
around with the settings
until it feels comfortable.
I tend to use the
following settings:
Velocity Scale 18.53,
Velocity Pressure 0.55,
Pressure Scale 0.92, and 
Pressure Power 2.69.
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Save, save, 
save your work
Save often and be sure 
to keep iterative saves 
along the way. There’s 
an iterative save option 
in the File menu that
creates a copy with 
a sequential number 
whenever it’s selected. 
During this project 
I made quite a large 
mistake which I then 
saved, but fortunately 
I was able to go back to 
a previous save, having 
only lost about 20 
minutes of work.

10 To the background
Now that our alien is coming along nicely, I feel it’s time to 

move onto the background. I create a new Normal layer and fill it with 
a warm middle value, then use the Apply Lighting effect with a few 
slightly different coloured spotlights to the layer. You’ll notice I place 
the lights where the rim light from the character originates. I do this as 
I feel it is a nice starting point to the background.

7 Blend the light
The Blender brush is my best friend 

here to make the rim light seem to flow 
over the form. I use the Blender often to 
soften features that are looking too sharp 
and hard. I start with splotches of paint 
and blend in where I need to. It’s a great 
way to remove line art.

9 The good part
I selectively apply 100 per cent 

white value spots to the appropriate areas. 
I refer to the photos of frogs to help me 
out. Don’t go overboard with the specular 
highlights – it’s useful to study the 
different ways light reflects on different 
materials. This is the only area in the 
painting that will have 100 per cent white 
applied as this is the centre of interest.

6 Starting to apply  
the rim light

I apply the light where the form turns 
towards the direction of the light source. 
I’m constantly thinking of the form and 
the perspective of light. I look at plenty of 
reference material of different examples 
of rim light to give me an idea as to how 
the light should be applied. I use my 
drawing brush in order to be able to create 
the sharp paint strokes I require to be 
suitable for applying accurate rim light. To 
add a slight subsurface scattering effect 
I use the Glow brush, or in some cases an 
Overlay layer to give it a more realistic feel 
in the way the light reacts with the skin.

8 Make it feel alive
I use the Overlay layer to apply 

secondary lighting. Using the Airbrush, 
any value above 50 per cent will lighten 
and saturate anything beneath it and 
anything below will darken but still 
saturate. It takes getting used to, but helps 
your images pop. I apply brightness to the 
brow, nose, mouth and chin and apply 
darker value to the edges of the form.

5 Give the skin texture
The lighting is from the front and slightly to the top right of the image, so I make 

sure the light is hitting the forms in the correct place. I add scales to the skin in a way 
that follows the form and has a random quality to it. I reference the frog photo often. 
Once I feel the basic skin lighting is at a suitable level I move on to the rim lighting. For 
this I choose a warm yellow light. 

4 Building the foundation of the skin
Now I’m starting to render the skin. I use a Round brush with the resaturation 

level low at around 50 per cent. With low pressure applied to the brush the more it 
blends, while pressing hard applies more opaque paint. Looking at the frog reference, 
I want to make the skin quite shiny. I start with a small range of middle values, because 
later on when I’ll add the specular highlights the skin will really pop.
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Resize brush

Ctrl+Alt+drag brush (PC)

Cmd+Alt+drag brush (Mac)

Use this shortcut to resize 

your brush on the fly. It’s

quicker than using the 

[ and ] keys.
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PAINTER X3 

CUSTOM BRUSHES: 
PETE’S DRAWING BRUSH

PETE’S PAINTING 
BRUSH

PETE’S AIRBRUSH

PETE’S BLENDER 2

GLOW

As the name implies I use 
this brush for drawing 
and sketching out my 
drawing. But I also use 
this for fine, sharp lines 
and details. 

This is the brush I use for 
the majority of my 
painting. It has a low 
resaturation setting, so 
the less pressure I use 
the more it blends. I use 
it to add paint and blend 
at the same time. 

I use this brush on my 
Overlay and Multiply 
layers to add large 
swathes of light or 
shadow. I also use it to 
soften areas with too 
much contrast, and to 
add smoke and dust.

This is a slightly modified 
version of the ‘Grainy 
Water’ default Blender. 
I use this all the time with 
a nice paper selected to 
smooth out forms and to 
blend out line art.

This is a great brush to 
add light to images. 
When I use this I keep 
the colour I select with 
a very dark value as to 
have a greater control 
with the brush.

16 Selective focus
A nice technique to use to keep 

something at the centre of interest is to try 
to simulate lens blur. I use the Soften 
effect (Effects>Focus>Soften) to blur each 
object according to how far they are from 
our main character. I raise the amount 
that the further-away-from and closer-to 
the viewer’s perspective the element is, 
relative to the centre of interest. After a 
few more tweaks, the image is done. 

13 Change it up
To make the image appear more balanced, I flip the foreground elements and 

change the hand and gun on the main alien. I feel the previous gun and hand was 
looking a little too bland. I also feel that there is also a bit too much flat space in the far 
background, so I add some alien-looking, drink dispensing bar technology. Again, 
I don’t worry too much about the fine details, because this will all be blurred later. I just 
try to make the silhouettes appear as interesting as possible.

15 Use some effects
Out of the gun (and the purple 

alien’s hand) I paint some energy tendrils. 
I just use the Airbrush at various sizes and 
then apply the Glass Distortion effect 
(Effects>Focus>Glass Distortion). At this 
stage I also start to add atmospheric 
effects like smoke and dust.

12 Transform the image
I still work away at different 

elements throughout the painting as I go 
along. I’ve decided to add a Dutch Tilt to 
the painting to make it a bit more 
dynamic. This is where the new 
Transform tools in Painter X3 come in 
really handy. They allow me to select 
multiple layers at a time so I can 
transform them all at once. This speeds 
up things greatly and means I can keep 
the different elements on different layers.

14 The weapon
I start to detail the new gun. 

Technological, man-made elements need 
to contrast with organic elements, and 
here geometric shapes, lines and hard 
edges are the name of the game. I add 
interesting bits and bobs (the odd greeble 
here and there) and try to break up 
elements with odd shapes. It’s handy to 
look up reference at every stage to get 
ideas flowing. Adding lights is a great way 
to create interest. I decided on a blue 
colour to offset the orange of the alien.

11 Add some friends
This is where I’ll start to add our 

ne’er-do-good pals in the background. 
I have plenty of fun creating different silly 
aliens using the same techniques I used 
when making our main character. They 
don’t need the same level of detail, as I 
have a plan to apply a lens blur effect at 
the end. Therefore, I don’t worry about 
the very fine details. I experiment at this 
stage with the Soften effect, which I’ll 
detail at the end.

In depth Alien design
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Free Transform
Ctrl+Alt+T (PC)

Cmd+Alt+T (Mac)This tool just got a lot more useful. It enables you to transform multiple 
layers at once.
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CREATE TENSION 
IN A GROUP SCENE
Discover how to add a feeling of unease to your figure designs, then 
create a character for Emma Vieceli’s upcoming book and win prizes!

lves and dwarves are long-
established elements of the 
fantasy cannon. In the Oni 
Press-published series The 

Avalon Chronicles, which I co-created 
with Nunzio DeFilippis and Christina 
Weir, several tropes of fantasy storytelling 
are turned around and challenged – and 
these established races definitely don’t 
escape that treatment.

In this workshop, I’ll be explaining my 
design process using the characters 
Kolinarr and Jourdain from the series as 
examples, and I shall give an insight into 

1 Setting up your tools
Using the Express keys option in 

the tablet’s properties (in the Start menu 
in the Wacom folder) you can customise 

the function of 
the keys. Your 
shortcuts appear 
as LED titles 
next to each key 
on the tablet. 
Setting your 
pen’s pressure 
sensitivity is 

important for health as well as art, as if 
you find your wrist aching after using the 
tablet, you may be pressing too hard. Try 
shaking up your nib settings, too.

3 Preparing inks 
and colour models

I generally work in pure black and white 
when I’m inking for print, but if you 
prefer your lines to be anti-aliased, 
change your layer’s colour model from 
pure black and white to grey or colour. In 
these modes, you’ll see a small anti-
aliasing tick-box available in your Pen 
tool options.

2 Roughing it out
I generally pencil my comics on 

paper and then scan in for inks. But for 
this workshop I’m working entirely 
digitally. If I were to flow-chart my digital 
work process, it might look something 
like this: Make a mess>Draw over that 
mess with a less messy mess>Refine mess, 
and so forth. Working digitally is 
liberating. My digital process is all about 
speed and having fun. I draw roughs, 
then I draw over them, refining as I go.

our Avalonian elves and dwarves. We’ll 
think about the key points of character 
creation, visual motif, societal impact and 
how wider world building is vital to 
creating a believable character.

I’ll also be talking a little about my 
digital tablet of choice – a Wacom Intuos 
– and I’ll be extending an invitation to all 
you lovely people to respond to the 
workshop and add a third character to the 
scenario for a chance to win some Wacom 
goodies. Whether you feel more inspired 
by the dwarves or the elves, that’s totally 
up to you!

If you’re interested in seeing in detail 
how these characters got to the ink stage, 
check out the free ImagineFX disc. You’ll 
find a video showing my process, from 
rough shapes using Manga Studio’s Pencil 
tool, up to the finished inks. Be warned: 
I’m not a tech-wizz, so it’s warts-and-all 
with no mistakes edited out. You’ll see 
how many redraws and edits I work 
through to reach my final inks.

If you want to further explore these 
characters, and plenty more, check out 
Avalon Chronicles Volumes 1 & 2, 
available now from Oni Press.

E

MANGA STUDIO

CUSTOM BRUSH: 
INK NIBS

I pencilled this image 
using the Manga Studio 
Mechanical Pencil, set to 
0.3mm, and then I inked 
it with the Maru nib, set 
to 0.6mm.
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Emma Vieceli
COUNTRY: England

Emma loves 
telling stories 
with pictures. 
She’s now 
working on 

the Alex Rider series for 
Walker Books.  
www.emmavieceli.com
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DIRECT LINK FOR 
WORKSHOP FILES
www.bit.ly/101-emma

WATCH THIS!
www.bit.ly/UNI101-emma
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Layer usage
The Layer Select tool 
enables you to select a 
few different layers at 
once. Once they’re 
highlighted blue, you can 
manipulate them at the 
same time, or merge 
them into one layer. 
Handy if you tend to 
work over several layers.

4 Evoking a feeling
The characters I’m drawing here are 

Kolinarr on the left, a dwarf; and Jourdain 
on the right, an elf. You’ll note their 
heights aren’t that different and their ears 
are similar. In Avalonian lore, the elves 
and the dwarves are actually the same 
race. Divided centuries ago through 
dispute, the elves took to the high ground, 
and the dwarves to the low. A lot of our 
understanding of the races comes from 
the jibes they’ve slung at each other for 
generations. No wonder these guys don’t 
seem to be getting on…

6 Racial differences
Inks done, it’s time to add my flat colours in Photoshop. Although the dwarves’ 

jibes would have us believe the elves to be pale and ghostly looking creatures, Avalonian 
elves are in fact fairly dark. They live closer to the sun, after all. Their dwarven 
counterparts on the other hand spend a lot of time working close to the ground and tend 
to be the paler of the two. By the same token, dwarves grow only an inch or so shorter on 
average than the elves – not that this has stopped elven jokes about their ‘short’ cousins 
being passed through to our world and vastly misunderstood.

5 Strike a pose
Facial expression goes a long way to telling a story in a single 

picture, but body language will amplify it massively. Kolinarr’s 
expression is fierce, but his head is bowed. His stance is strong, so he’s 
not cowering, but he’s also not raising his chin to pick an outward 
fight. Jourdain meanwhile is turning his head and closing his posture. 
He’s an elven stop sign right now, but his eyes aren’t looking away. 

7 Create a shade layer
I hide base colours to work in a 

single shade layer across the image, taking 
into account light source, and the 
different edging to the shadows for 
different surfaces. The elves are a proud 
lot, but not whimsical or airy-fairy in any 
way. In fact, quite surprisingly, they’re a 
very military-minded people. They’re 
strict, disciplined and adhere to the rules. 
As such, there are military elements to 
their design, merged with what we 
recognise. Younger elves will sport a 
cutout at their chest in open mockery of 
a certain dwarven tradition.

8 Customise the shade
Now that I’ve created a shade layer, 

I bring back my base colours and set my 
shade layer to Multiply. This has the effect 
of picking up on the colours beneath.
The individual dwarf clans are denoted by 
the colour of the ribbon worn on their 
hair. The hair is grown long in front of the 
ears, and supports metal rings. These 
rings are repeated throughout the design. 
Dwarves leave much of their upper body 
uncovered, because they wear their 
achievements on their skin. As a dwarf 
grows and learns, he or she will earn 
markings on their torso for life goals, their 
arms for work goals, and their back for the 
past. So you only need to take a glance at 
a dwarf to discover who they are, where 
they’ve been and where they intend to 
end up in the future.
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Rotate screen

Ctrl+R (PC) 

Cmd+R (Mac)

Handy for achieving long, 

smooth lines at awkward 

angles for your 

drawing arm.
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Try new nibs
It’s not just the shortcut 
keys and dial that you 
can tweak to your tastes. 
Once you’re comfortable 
with working on a 
graphics tablet, why not 
try customising the 
experience a bit more? 
Wacom provide several 
different nib types inside 
the pen holder. Just twist 
the top off and try 
mixing and matching 
some different levels of 
flexibility, texture and 
hardness. See what 
works for you.

How to enter
Simply follow Emma’s workshop then 
design a character and enter it at the URL 
below. Two runners-up will win an Intuos 
Manga each, and the winner will also have 
their character featured in Emma’s 
upcoming book (with full credit of course!).

To enter, download Emma’s art to use as 
a template from the competition website:  
www.futurecomps.co.uk/ifx-intuos. This 
competition closes on 13 November 2013. 
For all terms and conditions for this 
competition visit the website.

WIN! A WACOM 
INTUOS & MORE
It’s now your turn to invent 
a character, for print in 
Emma Vieceli’s upcoming 
book. Get your creation 
chosen and win one of 
three Intuos Mangas!

Clear selection
Ctrl+D (PC) 

Cmd+D (Mac)If no line comes out, a small active area may still be selected. Hit Deselect 
to free your
pen again.

12 Over to you – show 
us your character!

What we have here then are two 
characters engaged in quiet dispute… for 
now. Hopefully, you feel inspired to try 
your hand at designing an elf or dwarf to 
join this scene. Consider the design 
elements and racial traits I’ve mentioned, 
and consider too their expression and 
body gesture. Is your character going to be 
siding with someone, defending 
someone, or despairing of the pair of 
them? Are they a successful, military elf 
with braids and medals, or are they an 
accomplished dwarf with markings on 
their skin? Have fun with it! 

11 Overlay and texture
To add a final level of depth to the colour, I create a gradient 

over the characters and set it to Overlay on the layer drop down. I then 
tweak this in the same way I did the shade layer. Finally, I import a 
texture, set to Multiply, and lower its Opacity. It only needs to add 
depth rather than be seen. It seems that the elves and the dwarves can’t 
even agree on when to cover up.

9 Colourising the figures
Now I can tweak the Hue/Saturation levels on my shade layer while still picking 

out the base colours beneath. This can produce some great effects. Try playing about 
with it and see how different the mood of your piece can become! The elves, of course, 
find this practice of marking a little tacky and dirty. Their skin will remain unblemished 
throughout their life, but a high-performing elf may well receive medals, ranks or 
trinkets to mark their achievements instead.

10 Mixing shade styles
I hide my shade layer and start laying down simple shade with the Brush tool. 

Mixing this softer style with the sharper cel-shaded layer on top adds more depth to the 
colours. Elves attach a lot of value to their hair, perhaps tied with their link to the 
unicorns. A braid or a hairstyle may well signify an aspect of their character. The 
dwarves, however, tend to wear theirs short and practical, and the parts of their hair 
that they keep long are wrapped up in their clan colour.
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EXPOSÉ 11, the most inspirational collection of digital art in the known universe,
with 587 incredible images by 406 artists from 58 countries. 

www.ballisticpublishing.com

Ro
se

, C
ha

ic
ha

n 
A

rt
w

ic
ha

i, 
TH

A
IL

A
N

D

Ballistic_FuturePub_ImagineFx_Exp11.indd   1 27/06/13   9:09 AM



Magnificent Good AtrociousPoorOrdinary

The latest digital art resources are put 
to the test by the ImagineFX team…

RATINGS EXPLAINED

TRAINING
93 Sculpting a Stylized 
Character
Movie sculptor David Meng shares 
his techniques for building 
characters full of life and detail.

BOOKS
94 New reads
Burning Inside; Stan Lee’s How 
to Draw Superheroes; World 
War Z: The Art of the Film;  
The Shining Girls; Sick; The 
Secret of Abdu El Yezdi.  

SOFTWARE
90 Mischief
62 Solutions’ endless 
canvas promises to push the 
boundaries of art software.

SOFTWARE
92 Black Ink
The otherworldly brushes in this 
complex art package truly put the 
‘abstract’ into ‘abstract art’…

92 Black Ink
hh

SOFTWARE
92 iClone 5.5 Pro
It promises to take the pain out of 
creating 3D movies by supplying 
you with everything you need.

92 iClone 5.5 Pro
i kI
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Choice Award
Software and hardware with  
a five-star rating receives the 
IFX Artist’s Choice award!
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Price $65  Company 62 Solutions  Web www.madewithmischief.com  
Contact support@madewithmischief.com 

The immediacy of 
Mischief means that 

it’s perfect for quickly 
sketching out ideas 

and characters.

Mischief
TO INFINITY… AND BEYOND Mischief’s endless 
canvas promises to push the boundaries of art software

canvas, which can be zoomed and 
panned in just about every direction.

It’s mind-blowing stuff. To begin with 
we found ourselves drawing a line, then 
zooming in a little and drawing another, 
and so on. Before we knew it we had 
created a fractal that would have made 
Benoît Mandelbrot blush. More 
impressive is the fact that the lines 
don’t pixelate as you zoom in on them 
– Mischief is a little like a vector 
illustration program in this regard.

As a result of Mischief’s infinite 
nature it’s a far more liberating 
experience than other art packages, 
and it’s perfect for people who just like 
to sit down with a stylus and see what 
happens. Draw a tree and you could 
zoom in and create an army of tiny 
elves inhabiting it, or zoom out and 

U
pon first glance you’d be 

forgiven for thinking that 
Mischief is a tablet app for 
creating art. It has a similar 

minimalist layout to, say, SketchBook 
Pro, with little in the way of tools, 
menus and brushes. But there’s 
something very clever and 
potentially revolutionary going on 
behind its stripped-back exterior, 
something that would probably push 
the limited hardware of a tablet.

Mischief’s mischievousness lies in its 
approach to the canvas and brushes, 
and it’s something we can confidently 
say we’ve never seen before. Rather 
than being constrained by the 
dimensions you enter when you create 
a new image in Photoshop, Mischief 
presents you with a nigh-on infinite 

The beauty of Mischief is that images can 
be at once incredibly, infinitesimally 
detailed in some parts, and broadly 

sketched in others, such as the eyes in 
this image by Carly Sanker.

Reviews
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ARTIST INTERVIEW

CARLY 
SANKER

An early adopter explains how she 
uses the program for digital art

A freelance artist and 3D 
modeller in Boston in the US. 
She’s done work for Marvel, 
Mitsubishi and Harmonix.

www.carlysanker.tumblr.com

Why do you use Mischief?
I use Mischief because it’s 
lightweight and incredibly 
responsive. I always find myself 
wanting to draw with quality 
markers on Bristol board, but worry 
about wasting the expensive 
supplies. Mischief’s Highlighter 
tool has the same feel and 
appearance as high-quality 
markers, but in a digital format.

Did you find it easy to pick up?
Mischief is incredibly intuitive. It 
has the standard functions of any 
essential digital drawing or 
painting program, but with 
technology that artists haven’t been 
able to play with yet! You don’t 
even need experience as a digital 
artist to pick up a stylus and start 
creating art in Mischief.

Has the infinite canvas 
changed the way you work?
Absolutely. I feel free! I can fit 
multiple character sheets in one 
file. I can zoom in to display an 
entire new drawing. You have to see 
it to believe it. I really think it’s 
going to change the way we create 
and interact with art.

Do you find yourself using any 
programs on top of Mischief, or 
does it do everything you need?
I’ve done almost all of my freelance 
work using only Mischief. 
Sometimes I export my finished 
drawing into Photoshop to alter the 
Brightness/Contrast and Hue/
Saturation, but all of the drawing is 
usually done in Mischief.

Are there any features you’d like 
added to Mischief in the future?
Having mass manipulation tools is 
essential, but bringing my final 
drawings into Photoshop is quick 
and has just become a part of my 
process. At the end of the day, there 
are a few features that Mischief 
can’t do that other programs can 
– but there are things that Mischief 
can do that no other program can.

create an epic fantasy landscape of 
which the tree is only a tiny element. Or 
you could do both.

A somewhat inevitable limitation of 
Mischief’s semi-vector approach lies in 
its brushes. There are a mere 12 to 
choose from, including pens, pencils, 
crayons and markers. Although each 
can be altered in terms of width and 
opacity, there are none of the crunchy 
textures and viscous blobbiness of 
Painter, nor is there the ability to save 

and load brushes as in Photoshop. 
Fortunately, layer support is really 
good, and there’s a neat twist in that 
you can turn on 50 per cent 
transparency for the entire screen, 
which is great if you’re working from a 
film still or an image you’ve found 
online. Its file system is incredible in 
itself – the detailed image we created 
weighed in at just 250kb. You can also 
export your images, or portions of 
them, to JPG and PSD formats.

Mischief is a refreshing approach to 
drawing programs, and it makes 
Photoshop and Painter feel archaic in 
the way they’re restrained by 
traditional media. The brushes, or lack 
thereof, can be forgiven, as they’re a 
necessary evil due to the way Mischief 
works. We’d recommend giving the 
demo a go before you splash out, but 
we’re sure you’ll be up to mischief with 
it in no time. 

 A nigh-on 
infinite canvas that 
can be zoomed 
and panned in 
just about 
every direction 

As well as a pencil/brush tool, you’ll have 
the ability to create lines, squares, circles 
and shapes – although you’ll find yourself 
using the Pencil brush more often than not.

Mischief’s limited toolset is 
great for making quick and 
easy sketches on the fly.

The infinite zooming in 
capabilities mean you can 
paint in incredible detail.
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Software Mischief

Features
��Infinite definition

��Infinite canvas

��50 trillion to one 

zoom

��GPU parallelism

��Small file sizes

��JPEG import

��JPEG and PSD 

export

��Window 

transparency

��22 Layers

��18 brushes

System 
Requirements
Mac: OS 10.6 or 

greater

PC: XP, Vista, 7 or 8

Rating



Price ¤35  Company Bleank  Web www.bleank.com  Contact products@bleank.com

Black Ink
HIGHER MATHS The otherworldly brushes in this complex 
art package truly puts the ‘abstract’ into ‘abstract art’…

ike Mischief, Black Ink takes 
a less-conventional 
approach to digital art. 
The focus here is on 

brushes rather than an infinitesimal 
canvas, and it employs your 
computer’s GPU to give a fluid and 
responsive experience. 

When you first boot it up you’re 
given a range of predefined brushes, 
and they’re absolutely stunning. The 
Black Ink Felt and Round pens 
naturally expand and contract with 
pressure-sensitivity, and interesting 
brushes such as Volute and Crepe 
undulate with colour and transparency. 

Where Black Ink gets a little more 
complicated is in its controller. If you’ve 
ever used the effects tools in Premiere 
Pro you’ll know what to expect: stroke 
parameters can be dragged and 
arranged linearly, allowing a huge 
degree of customisation in terms of 
pressure, speed, time and length. 
Altering the order in which effects are 
applied can result in dramatic changes 
to the way brushes work.

Where Black Ink gets really 
complicated is in its mathematical 
equations. Clicking these enables you 
to set what happens with an 
oscilloscope-like graph, where you can 

alter variables such as amplitude and 
period. It’s all a bit mind-boggling, but 
the preview enables you to see how it’s 
going to affect your brushes.

It’s telling that Black Ink is going up 
for sale on Steam (Valve’s PC gaming 
service): it’s likely to appeal to geeks 
who love tweaking with formulae, and 
it feels like a piece of musical software 
at times. There’s certainly an audience 
for it, and some incredible pieces of art 
have already been created with it. But 
we’d say stick to Photoshop or Painter 
if you want a more immediate and  
less-experimental experience. 

L

Get to grips with Black Ink’s brushes and they’re 
perfect for creating dramatic and moody 
images, such as OrganCastle by Benoît Onillon.

From the Bleank forum, 
Bonnie ‘s Rey D Panda 
the Pirate King shows 
Black Ink’s rather 
ominous name doesn’t 
necessarily result in 
darker images.

iClone 5’s supplied characters are a little 
rudimentary. This one looks like Ben Stiller…

You can easily create a fantasy landscape by 
playing with iClone 5’s height maps.

HIDDEN COSTS A solid 
first into 3D animation 
and character creation

iClone 5.5 Pro

Features
��Unique brush

customisation tool

��Rich colour modes

��High performance

��Huge picture size

��64-bit rendering 

engine

��100-megapixel 

canvases

��GPU optimisation

��Brush history

��Colour history

��Real-time brush 

preview

System 
Requirements
PC: Windows XP, Vista

or 7. 1.6GHz processor,

1GB RAM, Pixel shader

3.0 graphics card, 

DirectX 9, 50MB hard 

drive space

Rating

Price $200
Company Reallusion
Web www.reallusion.com
Contact 1-408-573-6107

RATING 

Dabbling in the world of 3D 
animation is a natural progression 
for digital artists, but the learning 
curve is traditionally quite steep. 
Thankfully iClone promises to take 
the pain out of creating a 3D 
movie by supplying you with 
everything you need to get going.

Anyone who’s ever used a game 
engine to create 3D Machinimas will 
feel at home here, but beginners 
might find it a little frustrating to 
begin with. There’s plenty of 
documentation online, and lots of 
videos on YouTube, but 3D is an 
intricate field. Fortunately, iClone is 
a ‘what you see is what you get’ 
package, so what you’re seeing in 
the editor is the same as the 
outputted render.

Microsoft’s Kinect is supported, 
too, so you can jump around your 
bedroom and the on-screen 
characters will copy your moves. 
However, this is an extra purchase 
that will set you back $140, and if 
you want to import 3ds Max models 
you’ll also have to invest $100 in 
3DXchange. It’s annoying to have to 
spend so much extra to get fun and 
important features, so we’d 
recommend sticking to the defaults.

Reviews
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Publisher The Gnomon Workshop  Price $49  Format Download  Web www.thegnomonworkshop.com

ARTIST PROFILE

DAVID
MENG

Interested in the bizarre and 
grotesque from a young age, David 
had a natural leaning towards 
creature and character design in 
the film industry. He worked as a 
designer and sculptor for effects 
houses in Los Angeles. In 2004  
he joined Weta Workshop and 
worked on King Kong, The 
Chronicles of Narnia and District 9, 
where he served as lead creature 
designer for the movie’s Prawns. 

Most recently David 
was part of the 
concept team that 
designed the Kaijus 
for Pacific Rim.

www.davidmengart.blogspot.com

material pliable. He follows a familiar 
process of blocking out main forms 
– concentrating on gesture to invest 
energy into his figure – then refining 
the forms and finally working on the 
details. Non-sculptors will appreciate 
the parallels David draws between 
sculpting and illustration, name-
checking artists including Claire 
Wendling as he frames his modelling 
decisions in terms of creating design 
elements and controlling detail to 
focus attention towards the face.

Even if you’ve no ambitions to take 
up sculpting, David’s methods and 
principles will help you look at your 
own art through fresh eyes. But the 
video’s primary value is as an 
introduction to a fascinating creative 
field. James Gurney is one of many 
artists who recommend creating 
physical models of figures and 
environments as the ultimate 
reference source. David should give 
you the confidence and practical 
foundations to join them. 

GO APE Movie sculptor David Meng shares his process and 
expert techniques for building characters full of life and detail

e’ve come so far down the 
digital path that traditional 
hand-made crafts seem 
positively exotic when  

we see them in action. But there’s 
still a great deal that even the most 
technologically progressive artist can 
learn from the old ways, as sculptor 
David Meng proves in his second 
video for The Gnomon Workshop.

In two-and-a-half hours, David 
shares the key moments of a 
painstaking process that can take 
days, as he forms a clay orangutan 
figure over a metal armature. He 
presents the bewildering array of tools 
he keeps to hand: rakes, scoops and 
more. If you own ZBrush, you’ll 
appreciate seeing the physical 
counterparts to some of the digital 
brushes you use daily.

After constructing the steel 
armature – effectively the creature’s 
skeleton – David gets to work on 
adding and shaping clay, applying a 
flame where he needs to keep the 

W

Sculpting a Stylized Character

From the armature (above) to the 
finished, life-like sculpture (below).

Just like a painter,  
David pays the most 

attention to getting the 
face’s expression and 

detail spot-on.

Inspiration Software and training

November 2013 93

Topics covered
��Tools and supplies

��Assembling the

armature

��Blocking in large

forms

��Refining secondary

forms

��Skin texture

techniques

��Sculpting fur

��Detailing

Length
150 minutes

Rating



Author Jean-Sebastien Rossbach  Publisher CFSL Ink  Price ¤36  Web www.cfsl-ink.com  Available Now

which is broken down later in the book, 
depicts a warrior tackling a huge 
monster, and it looks like something 
from one of Bruce Dickinson’s 
nightmares. Morrigu gives us a 
brooding, levitating temptress that 
could well adorn an ancient gatefold 
LP found in a dusty record store.

A big part of Jean-Sebastien’s 
appeal and success is down to his 
versatility as an artist, though, and it’s 
not all permed quiffs and big riffs. His 
work for World of Warcraft apes the 
game’s recognisably chunky, brightly 
coloured style, but Jean-Sebastien 
brings his own sense of perspective 
and power to it. The same can be said 
for his Magic: The Gathering artwork. 
His suitably seedy comic covers for The 
Punisher switch to a pulpy style, 
whereas his take on Thunderbolts is 
airbrushed to perfection.

In his introduction, Jean-Sebastien 
puts his success as an artist not down 
to doggedly pursuing leads, but to 
producing really good art and letting 
the word spread among important 
people. But it’s in his personal work 
that a real darkness shines. Most 
interesting of these are his Alligator 
series, based on a song by French 

ART ROCK One of ImagineFX’s favourite artists explains his 
classic rock-fuelled pieces in this celebration of his work

ean-Sebastien Rossbach’s 
Burning Inside takes its 
name not from a bout of 
severe gastroenteritis, but 

from a song by US industrial metal 
band Ministry. They’re one of Jean-
Sebastien’s favourite bands and his 
love of music is evident throughout 
the book. Chapters start with lyrics 
from David Bowie and The Velvet 
Underground, and his personal work 
nabs names from songs and artists.

It’s telling that Jean-Sebastien 
names Iron Maiden as one of his 
favourite bands, as some of the art 
here exhibits a certain 80s album cover 
quality. His work Disturbing the Beast, 

J

Burning Inside

Jean-Sebastien lists 
Iron Maiden as one of 
his favourite bands in 
his rock-influenced art 
book and it’s easy to 
see the influence.

Several of Jean-Sebastien’s paintings could easily 
be mistaken for rock album covers.

singer Hubert-Félix Thiéfaine. They’re 
representations of ecological disasters, 
featuring dismembered, ghostly 
women spewing oil into sickly oceans.

Jean-Sebastien refers to his failed 
music career in his introduction, stating 
that music is a relatively “pure” artform 
in its abstraction and intangibility, 
whereas the works he produces are 
more of a craft. From where we stand, 
it’s the other way round – Jean-
Sebastien’s ability to turn his hand to a 
range of styles and genres, and his skill 
in creating drama and gut-churning 
reactions, make him feel like the artistic 
equivalent of an 80s rock god.
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The book aims to 
please art buffs and 
wannabe screenwriters.

e get plenty of ‘How To’ 
books in the ImagineFX 
postbag, but very few are 
written by an industry 

legend. X-Men and Avengers co-
creator Stan Lee’s How to Draw 
Superheroes follows similar tomes 
How to Draw Comics and How to 
Write Comics, and like those – and 

ather than going down the 
straight-up art book route, 
Titan has taken an 
interesting, if not entirely 

successful, approach to its World 
War Z tie-in. This ‘llustrated 
companion’ to the zombie 
apocalypse movie includes both art 
from the film and the complete 
shooting script – a move which may 
well be designed to capture both film 
art buffs and wannabe screenwriters 

Stan Lee’s How to Draw 
Superheroes

World War Z: The Art of the Film

Author Stan Lee  Publisher Watson-Guptill  Price £18  Web www.watsonguptill.com  Available Now

Screenplay Matthew Michael Carnahan, Drew Goddard, Damon Lindelof  Publisher Titan Books  
Price £17  Web www.titanbooks.com  Available Now

SUPER ART The X-Men and Avengers co-creator 
shares his comic art secrets in a must-have book

CROWD PLEASER? A belts-and-braces attempt at an 
‘Art of’ book that, oddly, doesn’t have very much art in it

Also look at…
Be inspired by the latest 
recommended fiction

the man himself – it’s colourful and 
larger-than-life.

Stan briefly touches on heroic tales 
of yore before moving on to comic 
archetypes – the upstanding S-type 
(Superman) and the darker, more 
grounded B-type (Batman). He shows 
how to create nemeses, sidekicks and 
pets, peppering the book with 
examples from his work, and other 
illustrators. Stan uses freshly created 
superheroes to illustrate his ideas on 
making human characters work.

He may be over 90, but this book 
proves that Stan still has lead in his 
pencil and a thorough understanding of 
the genre. Admittedly, we are slightly 
suspicious about the three co-writers 
employed here, but it’s still a must-have 
for anyone thinking about creating their 
own super-powered protagonist.

RATING  

who like to pore over every detail  
of dialogue and plot.

The problem is that screenplays 
consist of massive amounts of text,  
and as a result behind-the-scenes 
insight into the creative process is 
reduced to mere single-sentence 
quotes from the film’s makers. The 
exception to this is – somewhat 
bizarrely – a mere double-page spread 
dedicated to the film’s weapons.

The art that’s represented at the 
back of the book does go some way to 
offer an insight into the design of the 
movie’s brand of zombies. But again, 
very little exposition of the whys and 
hows of the design are revealed.

While we appreciate the idea of 
being able to compare a film’s narrative 
to its art, we’d rather have a book 
dedicated to either, than this 
asynchronous mishmash of the two.

RATING  

Stan creates new superheroes 
to illustrate some of his points.

W

R
The Shining Girls
Author Lauren Beukes
Publisher Harper  Price £13
Available Now

 
The usual dry 
descriptions of crime 
scenes and criminals 
merely heighten the 
strangeness of Lauren 

Beuke’s tale of a time travelling 
serial killer hell-bent on murdering 
his “shining girls” before they can 
change history. You could be 
reading any number of well-
researched crime novels until the 
decades slip by and the race to find 
a killer across time takes a quantum 
leap into the past, and the future.  
A memorable and unusual triumph.

The Secret of Abdu 
El Yezdi
Author Mark Hodder
Publisher Pyr  Price £12
Available Now

 
Daring Victorian 
explorers, rogue ghost 
informants and an 
assassinated Queen 
Victoria – the fourth 

Burton and Swinburne is packed 
with suitably outlandish historical 
characters in a web of intrigue.

Captain Richard Francis Burton 
has been knighted, but things are 
about to get strange quickly as he 
gets embroiled into a secret society. 
This is funny, imaginative 
steampunk prose, well worth the 
price of the ticket back in time. 

Sick
Author Tom Leveen
Publisher Amulet  Price £11
Available 1 November

 
A virus turns a Phoenix 
school into a zombie 
playground, young minds 
ripe for eating. With the 
military at the gates and 

the undead in the halls a group of 
teens must find a way out. The teen 
angst is subdued in favour of smart 
one-liners and genuine teen-voices. 
Gruesome discoveries and well-
paced writing take Sick away from 
the norm and a smart twist or two 
leave you wondering who the real 
monsters actually are.

Inspiration Books
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LOCATION Singapore  RECENT PROJECT The Powerful: NYC, League of Legends, Galaxy Saga  WEB www.imaginaryfs.sg

page, he founded Imaginary Friends 
Studios, one of Singapore’s most 
renowned graphics houses.

“We just wanted to create a 
collaborative environment to do 
commercial illustration,” says Stanley. 
“Our mantra running the studio was 

‘for artists by artists’ and it 
still is.” Stanley’s friends 
and co-founders of the 
studio, Kai Lim and 
Kendrick Lim, are 

Imaginary Friends Studios
ARE FRIENDS ELECTRIC? How this Singapore-based studio straddles 
both the East and West – and has built up an impressive client base

tanley Lau is known online 
as Artgerm, and whether 
you interpret his avatar to 
mean he’s been bitten by 

the art bug, or his art is infectiously 
popular, it’s befitting. His Pepper 
character became an online 
sensation, inspiring countless digital 
artists to engage with Stanley’s 
clean, colourful, manga-inspired 
style. On top of achieving more than 
50 million views of his deviantART 

S

Tears of a Distant Sun, 
by Kai Lim, is suitably 

epic with a good use of 
golden-hour hues.

DCWJ’s stunning take  
on Jewel Melody from 
Galaxy Saga proves  
that iPhone games  
have come of age.

 Everyone had imaginary 
friends as kids and now we 
want to be represented by  
that fun spirit  

anything but imaginary. “As kids, 
everyone had imaginary friends, and 
as adults now we want to be 
represented by that fun spirit that 
imaginary friends provided.”

Stanley and his very real chums had 
a huge range of skills they felt they 
could use to establish the studio back 
in 2005. “We had experience ranging 
from advertising, editorial, graphic 
design, animation, and 2D and 3D 
illustration,” he says. “I believe this 

gave us a more holistic approach to 
our service and philosophy, enabling 
us to tackle a wider variety of creative 
challenges or offer unique solutions 
for people.”

In its eight years Imaginary Friends 
Studios has picked up work for major 
players in gaming such as Ubisoft, 
Square Enix and Capcom. Part of its 
success lies in its location: Singapore 
has historically been a trading post 
between east and west, and even in 
today’s hyper-connected world it 
maintains that role.

“It’s an advantage to be 
at this part of world,” says 
Brandon Chng, a digital 
artist with the studio. “We 
get great exposure to 
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PROJECTS Star Wars – The Essential Guide to Warfare, Street Fighter III: Third Strike Online Edition

both the east (anime) and west 
(American comic) illustration styles. 
We tend to be more flexible and are 
given fair opportunities to work on 
various different projects. As a gamer 
myself, it feels really great to work on 
projects and property that I love.”

Despite his many successes, Stanley 
is acutely aware that the studio needs 
to be in a process of continual 
transformation, in order to stand out 
in the increasingly crowded world of 
digital art. While it used to train 

beginners in their craft, it now 
employs what Stanley terms a “hit the 
ground running” approach as tutelage 
drained the company’s resources and 
didn’t inspire growth among 
established members of staff.

“It’s a natural tendency for people 
to stay in a comfort zone, but the truth 
of the matter is everyone needs to 
evolve or die,” says Stanley. “In 
constantly trying to push our own 
boundaries, we hope we’re doing our 
own part for the industry, and for the 
arts which we love. Our diversity, 
interestingly enough, has proven to  
be our core strength over the years, 
because we get to leverage on every 
artist’s personal style.”

Brandon echoes Stanley’s views on 
the studio. “Occasionally, when I meet 
a creative block while illustrating an 
idea or concept, the guys around will 
help out by providing some ideas,” he 
says. “There are times when we’re 
more engrossed with certain fun and 
exciting jobs and want to spend more 
time on them. But as this is contracted 
work, and schedule-based, it’s usually 
a challenge to balance the work-fun 
ratio and meet the deadline.” 

Brandon completed the 
earlier stages of sketch 
and lines for Valkyrie, 
while Derrick went on 
to paint up and 
complete the image.

“More often than not 
we get treated like a 
boutique, where 
clients approach  
us for the services  
of individual artists  
on our roster,”  
says Stanley.

Brandon’s take on Magic: The Gathering – Tactics’ 
Serra Angel shows the studio’s versatility.

How do you all complement 
each other’s skills?
Each of us have a skill set that we’re 
more specialised in. Sometimes a 
project is broken down into phases 
where one of us would work on 
sketches and line art, while another 
bring it to final paints. It’s like 
collaborating with two artists and 
we can get really interesting results 
or a style that shows the best of 
both worlds.

What does an artist need in a 
portfolio to get noticed at 
Imaginary Friends Studios?
It’s good to see a variety of works 
from line art, sketches and 
conceptual stuff to full illustrations. 
It’s always nice and interesting to 
see the range of what someone  
can do with their art.

Why would you recommend 
working at IFS?
It’s a great place for artists to pick up 
new skills and grow. Since we’re 
always around each other during 
our creative process, it’s easy to get 
opinions, exchange tips and 
explore new ideas together. Mostly 
it’s about inspiring and encouraging 
one another to improve on what we 
do best and have fun while at it!

How important is it to 
experience working with clients 
from different countries and 
what has this brought to 
Imaginary Friends Studios?
It’s great experience working with 
clients from all over because we 
interact with different cultures and 
expectations, and are exposed to 
learn and develop new skills and 
try out new stuff.

What advice would you have  
for someone wanting to be a 
concept artist?
Have the desire to improve and 
learn. Sometimes we get too 
comfortable applying the same 
style on our artworks. It’s important 
to try out something different once 
in a while.

ARTIST INTERVIEW

DERRICK 
CHEW

The senior artist on what it’s like 
to work for the company

Derrick – aka DCJW – spends 
his spare time fighting aliens 
while wearing a figure-hugging 
Ultraman jumpsuit. Apparently. 

www.dcwj.deviantart.com
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Delve into our website and get more 
from your ImagineFX community

Learn from our ever-increasing library of workshops from your favourite artists, including 
Simon Dominic, Raymond Swanland and Peter Stapleton: www.bit.ly/ifx-pstapleton.

Professional tutorials

Take advantage of exclusive discounts and 
deals: http://beta.imaginefx.com/shop.

ImagineFX Store
Get the latest news and see fantastic art: 
http://beta.imaginefx.com/tag/blog.

News and blogs

Unify fantasy genres
Maciej Kuciara designs a fantasy 
heroine using different elements: 
www.bit.ly/ifx-fantasygenres.

Paint an alien character
Follow McLean Kendree’s advice 
on concepting a humanoid alien: 
www.bit.ly/ifx-aliencharacter. 

Adapt Frazetta’s approach
See how John Stanko painted this 
stunning cover image for issue 96: 
www.bit.ly/ifx-jstanko96.

Website
Community
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Follow our pro artists 
advice as they guide 
you through their  
painting processes

Watch the latest 
video tutorials 



Uploading your art is easy and quick. Once registered you can join our 
friendly community, learn new skills and enter weekly challenges .

Galleries and community

Visit www.imaginefx.com

Set up your personal 
profile and upload  
your art instantly.

Will your art be chosen 
and promoted as  
Image of the Day?

Coming soon! Every reader will get 
a Lightbox tool to display and 
explore the Gallery.

Be a part of a lively community. Meet new friends to 
share tips, Favourite images and comment on art.

Our new Gallery is accessible and 
easy to navigate. Why not join 
today and start sharing?

Our new Gallery is accessible and 
ea
today and start sharing?

uruur

Coming soon! Every reader will get 
a

g y

explore the Gallery.
Be a part of a lively community. Meet new friends to 
share tips, Favourite images and comment on art.

p

Will your art be chosen 

Image of the Day?

Set up your personal 
p
your art instantly.
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